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Model Navigation

Enterprise Architect stores valuable organizational
information in a repository, and over time these repositories
will become large and will often contain many thousands of
elements and connectors. It is critical to be able locate
entities in the repository, and Enterprise Architect provides
a rich set of features for this purpose.

The Project Browser contains a hierarchical view of the
repository elements, features and diagrams; knowledge of
the Package hierarchy will help you to navigate through the
repository and drill into and out of Packages, locating what
you are looking for. There are also Package, element and
resources browsers that help you to find items in the
repository.

A Navigator Toolbar helps you to navigate the hierarchy of
Packages in the repository using a textual breadcrumb
control, showing you the current Package location.

As models become larger, using the powerful and flexible
search function will make it easy to find an entity or a set of
entities that meet defined criteria. There are a large number
of built-in searches, but there is no limit to the searches that
can be created and even novice users can define powerful
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and time-saving searches.

Elements in well-formed models are articulated together
using relationships that create a graph of elements. The
ability to traverse this graph is often termed traceability, and
Enterprise Architect has a series of features such as the
Traceability Window that make it easy to visualize this
graph of interconnected elements, bringing the repository to
life.

Facilities

Facility

The use of the Project Browser and Package Browser to
navigate and explore your model

How Model Views provide different perspectives and
'entry points' into a model.

Finding elements and relationships using the Model
Search tools and custom queries

Traceability tools to help track completeness,
dependencies and other behavioral and structural
relationships

Use of the Diagram List or Package Browser to view
model elements in a conventional list based manner
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Use of the Relationship Matrix to understand and track
relationships between model elements in a spreadsheet
view

Using Diagram Filters to highlight information in
diagrams

Using the Traceability window to explore model
dependencies

Finding and working with Element Relationships
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Navigate: Exploring Your Model

Navigating is the ability to explore the hierarchical content
of a repository, using the tree view windows such as the
project, Package, resources and element browsers, the
Traceability window, and the list view windows such as the
Package and diagram lists. There is a wide range of other
views that help you to navigate through content stored in a
repository, such as the Gantt Chart for exploring how
elements are affected over time, and the Resources Browser
that stores assets such as templates, patterns and matrices.
The Navigator toolbar also shows a bread crumb view of the
Package hierarchy. These features are particularly useful
when you have some familiarity with the structure of a
repository, but you can always use the powerful search
features to find random content.

Tools

Tool

The Project Browser, the main interface element for
exploring and navigating your model
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The Package Browser - a tabular, editable view of
elements in a selected Package, which can be displayed in
the main workspace.

The Diagram List - a tabular, editable view of elements
in a selected diagram, which can be displayed in the main
workspace

Model Views provide different perspectives and 'entry
points' into your model

A Diagram Slide Show displays a number of related
diagrams in a presentation, for illustration and
comparison of features of your model.

The Pan and Zoom window helps you to navigate around
very large diagrams.

The Summary View window shows a brief, read-only
summary of the general properties of the currently
selected:

Element (including Packages)·

Attribute·

Operation·

Test·

Maintenance item·

Resource·

The Summary View immediately displays general
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information on the item in context, so you can quickly
scan a number of items to locate and check those of
interest to you.
You can highlight a section of text or the complete
content, and copy it to be pasted into an external
document.
The Summary View does not display details for Views,
Model Packages, diagrams, instances or connectors.
Select the 'Start > Explore > Properties > Summary'
ribbon option.
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The Project Browser

The Project Browser is a window that displays Packages,
diagrams, elements and element features in a tree-like
structure, reflecting the arrangement of elements and
Packages within your model. The Project Browser is the
primary mechanism for browsing and exploring your model
and is the jumping off point for many of the most important
features in Enterprise Architect. You can use it to navigate
through the Enterprise Architect project space and:

Review the structure, content and organization of your·

model

Drill down to specific elements·

Drag and drop elements and Packages within the model·

Copy (duplicate) whole Packages·

Import/export model information·

Set up Version Control, locking, execution analysis and·

many other aspects of the model tied to a particular
Package

Document models·

Import code, xmi and csv files, database schema and other·

external data sources

The Project Browser provides a range of context menus
through which you can perform additional actions such as
adding new Packages, creating diagrams, renaming items,
creating documentation and other reports, and deleting
model elements. You can also edit the name of any item in
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the Project Browser by selecting the item and pressing F2.

The full model structure is represented in the 'Global' tab of
the Project Browser.

You can also select a View, Package or element at any level
and focus the display on just the portion of the structure
underneath that object, in the 'Context' tab. See the Using
the Context Tab Help topic.

The illustration shows, in the Project Browser tab bar, a
horizontal scroll bar. You can select an option to show or
hide this scrollbar, from the 'Application Look' dialog. See
the Visual Styles Help topic.

Access

Ribbon Start > Explore > Browse > Project
Browser or
Show > Portals > Window > Explore >
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Project Browser

Keyboard
Shortcuts

Alt+0

Views

The Project Browser can be divided into Views, each of
which contains diagrams, Packages and other elements. A
default View hierarchy is described here, but you can create
different Views to suit your requirements.

View Description

Use Case
View

The functional and early analysis View,
containing Business Process and Use
Case models.

Dynamic
View

The dynamics of your system, containing
State Charts, Activity and Interaction
diagrams.

Logical View The Class Model and Domain Model
View.

Component
View

A View for your system components. The
high level view of what software is to be
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built (such as executables, DLLs and
components).

Deployment
View

The physical model; what hardware is to
be deployed and what software is to run
on it.

Custom View A work area for other Views, such as
formal requirements, recycle bin,
interview notes and non-functional
requirements.

Selective Collapse to the parent element or
Package

When you are working on an expanded project in the Project
Browser, you might want to locate the parent element or
Package of an item, and/or collapse the structure under that
parent element or Package.

Ste
p

Action

1 Position the cursor on an item within the element or
Package.

Press the right-arrow key on the keyboard to
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2 highlight the parent.

3 Press the same key again to collapse the structure
under that parent element or Package.

Adding elements from the Diagram Toolbox

When you have a structure in the Project Browser, you can
add elements to it by picking them up from the Diagram
Toolbox and dropping them onto the parent element or
Package. To do this, you:

Click on the element icon in the Diagram Toolbox, then·

click on the parent Package or element in the Project
Browser to select it, and click again to drop the element
under the parent

You cannot add objects that do not display in the Project
Browser, such as Note elements, Text elements, connectors
or Boundaries.

If an element is of a type that cannot be added as a child of
the object in the Project Browser, an error message displays.
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Using the Context Tab

In the Project Browser, the 'Context' tab provides a
simplified, focused view of a section of the model, separated
from the full structure. This helps you to concentrate on the
area of the model you are working on, and is very useful
when you are re-organizing that section as it reduces the risk
of dragging objects into the wrong area of the model.

Access

Ribbon Start > Explore > Browse > Context
Browser or
Start > Explore > Browse > Project
Browser > Context or
Show > Portals > Window > Explore >

(c) Sparx Systems 2018 Page  17 of 281



User Guide - Model Navigation 21 December, 2018

Context Browser

Keyboard
Shortcuts

Alt+0 > Context

Functionality

The tab shows the View, Package or element currently
selected in the 'Global' tab, and its subordinate objects. It
also displays the child objects of subordinate elements, but
not of subordinate Packages. To display the child objects of
one of these Packages, you double-click on it to make it the
focus of the tab.

If the selected object is a Package or element without child
objects, or a diagram, the tab has that object's parent in
focus at the top, rather than the object itself.

If the currently selected object is not a model Root Node,
then the second item in the 'Context' tab is a  icon.
Double-clicking on this switches focus to the next level up
in the model.

Clicking on an object in the 'Context' tab will cause
Enterprise Architect to navigate to that object, displaying its
properties and features in other windows that are open.

Double-clicking on a child object that itself has subordinate
objects in the 'Context' tab makes that object the focus of the
tab, displaying it at the top of the tab. If it does not contain
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other objects, the 'Properties' dialog displays.

Right-clicking on an object in the 'Context' tab displays the
same context menu as in the 'Global' tab of the Project
Browser.

The 'Context' tab works very well in combination with the
Navigator toolbar, which displays the full hierarchy path of
any object you highlight in the 'Context' tab. As you change
the object in focus on one of these tools, the other is
automatically updated as well. The 'Context' tab is another
view of the selected section of the model, and any changes
you make through the tab are reflected in all other views of
the model, such as the 'Global' tab.
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Project Browser Header Bar

The Project Browser header provides access to several
operations you can perform on your project structure and
content, including opening the project in the first place. You
can use the options in the header bar to create a new model
through the Model Wizard, add Packages and diagrams to
an existing model, and move objects up and down within
their object groups and parent structures. These and
additional options are also available through the menu
displayed by the 'Hamburger' icon.

When you first open Enterprise Architect, all the icons
except for the 'Hamburger' are grayed out. You can either
select a model from the 'Recent' list on the Start page, or you
can click on the 'Hamburger' and select the 'Open Project'
option. This option displays the 'Manage Projects' dialog,
through which you can locate and open the required project.

Access

Ribbon Start > Explore > Browse > Project
Browser or
Show > Portals > Window > Explore >
Project Browser
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Keyboard
Shortcuts

Alt+0

Icon Options

Option Action

New Model
from Pattern

Click on this icon to create a new Model
Package in the project, underneath a
selected Root Node.
Shortcut: Ctrl+Shift+M

New Package Click on this icon to create a new child
Package under the selected Package.

New
Diagram

Click on this icon to create a new child
diagram under the selected Package or
element.

Move Object
Up

Click on this icon to move the selected
object further up the Project Browser,
within its parent Package.

Move Object
Down

Click on this icon to move the selected
object further down the Project Browser,
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within its parent Package.

Hamburger Click on this icon to display a drop-down
menu of options to perform various
operations on the model, as described in
the Menu Options table.

Menu Options

Name Action

New Model
From Pattern

Select this option to create a new Model
Package in the project, underneath a
selected Root Node.
Shortcut: Ctrl+Shift+M

New Package Select this option to create a new child
Package under the selected Package.

New
Diagram

Select this option to create a new child
diagram under the selected Package or
element.

Open Project Select this option to open an existing
project, or to create a new project from
scratch or from a base template project.
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Shortcut: Ctrl+O

Reload
Project

Select this option to close and reload the
current project, refreshing the Project
Browser (in a multi-user environment, to
bring in changes made by other users
sharing the project).
Shortcut: Ctrl+Shift+F11

New Element Select this option to create a new child
element under the selected Package or
element.

Find in
Project
Browser

Select this option to perform a simple
search for a text string in the Project
Browser.

Documentati
on

Select this option to display a submenu
from which you can select to generate, on
the selected Package in the Project
Browser, a:

Document report·

Web report·

Joomla! Article or·

Diagram Only report·

Shortcuts: F8
Shift+F8
Ctrl+Shift+F8
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Code
Generation

Select this option to display a submenu
from which you can select to:

Generate source code·

Generate DDL·

Import a source directory·

Import a binary module·

Import a Resource Script·

Import a database schema·

Generate Package contents to·

synchronize with Package code
Reset the source code language·

All these options operate on the selected
Package.
Shortcut: Ctrl+Alt+K
Ctrl+Shift+U
Ctrl+Alt+M
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Project Browser Context Menus

The Project Browser provides a wide range of options to
work on the objects it contains. These options are presented
through a number of context-sensitive menus.
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Model (Root Node) Context Menu

The Root Node in the Project Browser is the Model element.
You can have more than one Root Node and hence more
than one Model element. The first level Packages beneath
the Model node are sometimes referred to as Views as they
commonly divide a model into categories such as Use Case
Model and Logical Model. You can perform a wide range of
operations on the Model nodes of your project, by selecting
options from the Model context menu in the Project
Browser.

Access

Context
Menu

Right-click on the Model Node

Options

Option Action

Specialize Select this option to access two sets of
functions:
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Scripts - scripts created using the·
Scripting facility, to be executed on
Model Nodes; click on a script name to
execute it (this option is not shown if
no appropriate scripts have been
created)
Extensions - a list of the enabled·
technologies on the system, each of
which provides options for performing
technology-specific operations on the
Package; these options are available in
the Professional, Corporate, Unified
and Ultimate editions of Enterprise
Architect

Add a Model
using Wizard

Select this option to add further models
using the Model Wizard.
The list of available Model Pattern
Technologies includes the MDG
Technology Builder, which creates a
Model Package containing templates that
you can use to generate a new MDG
Technology containing a set of Profiles.
Shortcut: Ctrl+Shift+M

Add Root
Node

Select this option to create a new model
root, without any subordinate structure or
content.
A prompt for the model name displays.

(c) Sparx Systems 2018 Page  27 of 281



User Guide - Model Navigation 21 December, 2018

Add View Select this option to create a new View
(Package) underneath the model root
node.
The 'Create New View' dialog displays.

Package
Control

Select this option to access the Package
Control submenu, which provides these
options:

Lock Package (if the project has User·

Security enabled); the 'Lock/Unlock
Package(s)' dialog displays
Import a Model Branch, and·

Version Control Settings·

Full Structure
for
Duplication

Copy the element(s) of the selected
Package to the clipboard in XMI format.
(Shortcut: Ctrl+Shift+C)

Paste
Package from
Clipboard

Select this option to paste a child Package
from the clipboard into the selected
Package.

Clone
Structure as
New Version

Select this option to build a clone of your
current Root Node hierarchy, including
diagrams, and update each object with a
user defined version number. All diagram
elements contained in a clone diagram are
included only as linked elements
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(references).

Delete
Project Root

Select this option to delete the Model
Root node, after you have already deleted
all of its subordinate Views and
Packages.
A prompt displays for you to confirm the
deletion.

Help Select this option to display the Help
topic for the Project Browser.
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Package Options in the Project
Browser

The 'Package' context menu in the Project Browser provides
a wide range of options for displaying, organizing and
operating on the Packages in your model.

Access

Context
Menu

Project Browser | Right-click on Package
or View

Options

Option Action

Specialize Select this option to access two sets of
functions:

Scripts - scripts created using the·

Scripting facility, to be executed on
Views and Packages; click on a script
name to execute it (this option is not
shown if no appropriate scripts have
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been created)
Extensions - a list of the enabled·

technologies on the system, each of
which provides options for performing
technology-specific operations on the
Package; these options are available in
the Professional, Corporate, Unified
and Ultimate editions of Enterprise
Architect

Collaborate Displays a short menu of options to
exchange electronic notes with team
colleagues, in the form of Reviews,
Discussions and, if User Security is
enabled, Chats and Model Mail
messages.

Properties Select this option to display the
'Properties' sub-menu for the Package
element.

Open
Package In

Select this option to display the contents
of the Package either as a text description
in the Specification Manager, a list of
objects with their selected properties, or a
Gantt chart showing resource allocations
and progress.

Add a Model Select this option to add another Model
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using Wizard Package to the model or View, using the
Model Wizard.
Shortcut: Ctrl+Shift+M

Add a
Package

Select this option to add another Package
to the selected Package.
Shortcut: Ctrl+W

Add Diagram Select this option to add a new diagram to
the selected Package.

Add Element Select this option to add a new element to
the selected Package.
Shortcut: Ctrl+M

Package
Control

Select this option to access the Package
Control submenu, which provides these
options:

Lock the Package (if the project has·

User Security enabled)
Import a Model Branch, and·

Version Control Settings·

Clone
Structure as
New Version

Select this option to build a clone of your
current Package hierarchy, including
diagrams, and update each object with a
user defined version number. All diagram
elements contained in a clone diagram are
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included only as linked elements
(references).

Copy/Paste Select this option to access a menu of
options for copying and moving the
Package contents to other areas of the
model.

Contents Select this option to reorganize the
Package contents after making changes.

Set View
Icon

Select this option to display the 'Set View
Icon' dialog, on which you select one of
the six standard View-type icons to
display beside the View name.

Delete
<packagenam
e>

Select this option to delete the selected
Package and its contents. A prompt
displays to confirm the deletion.

Help Select this option to display the Help
topic for the Project Browser.
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Properties Sub-Menu

The Package 'Properties' context menu provides a range of
options for displaying and updating the properties, notes,
Tagged Values and Linked Document of a Package element,
and for locating the Package in any diagrams that contain it.

Access

Context
Menu

Project Browser | Right-click on Package
| Properties

Options

Option Description

Properties Displays the Properties window for the
Package element, which you can use to
view and modify the element properties.

Special
Action

Displays the 'Properties' dialog for the
selected Package.
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Notes Displays the Notes window, showing any
notes that have been written for the
Package element.

Tagged
Values

Displays the Tagged Values window,
showing any Tagged Values (extended
properties) that have been created for the
Package element.

Linked
Document

Displays the 'Linked Document' tab of
the Document window showing the
Linked Document for the Package, if one
exists.
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Package Control Sub-Menu

The Package 'Package Control' context menu has two forms:

The 'Controlled Package' form when the Package is not·

under Version Control, that provides options for locking a
Package, importing a model branch into another model
and setting up Version Control

The 'Package Version Control' form that provides a wider·

range of options for managing the Package when it is
under Version Control

Access

Context
Menu

Project Browser > Right-click on
Package > Package Control
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Copy/Paste Sub-Menu

The Package 'Copy/Paste' context menu provides a range of
options for copying or moving Packages between parent
Packages or between models, within the Project Browser. It
also provides options for pasting copied elements and
diagrams into a Package.

Access

Context
Menu

Project Browser | Right-click on Package
| Copy/Paste

Options

Option Action

Cut Select this option to remove the selected
Package from its parent Package, to be
pasted under another Package. The
selected Package remains where it is until
the Paste operation is invoked.
Shortcut: Ctrl+X
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Paste Select this option to paste a cut Package
under the selected Package. If the
selected Package is not a valid target, the
'Paste' option is grayed out.
(This option is not available for copied
Packages - use the 'Paste Package from
Clipboard' context menu option.)
Shortcut: Ctrl+V

Copy to
Clipboard

Select this option to copy the selected
element(s) (including the Package
element) to the clipboard. You select one
of two sub options:

ID for Pasting as Link - copy the·

element IDs to the clipboard to be
pasted into a diagram as links to the
actual elements (Shortcut: Ctrl+C)
Full Structure for Duplication - copy·

the element(s) of the selected Package
to the clipboard, in XMI format for
pasting as new duplicate elements in
another Package (Shortcut:
Ctrl+Shift+C)

Paste
Package from
Clipboard

Select this option to paste a Package from
the clipboard into the selected Package.
Shortcut: Ctrl+V
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Paste
Element(s)
from
Clipboard

Select this option to paste elements
copied to the clipboard into the selected
Package.
Shortcut: Ctrl+V

Paste
Diagram

If you have copied a diagram from
another Package, select this option to
paste the diagram into the
currently-selected Package.

Copy
Documentati
on Bookmark

When using the Legacy Report
Generator, if you want to create a
complex document that consists of
sections of one or more document
reports, rather than one complete report,
you can create a master document in
Microsoft WordTM and within it create
links to the report sections using their
bookmarks.
Select this menu option to copy the
bookmark on the selected Package to the
clipboard, to be pasted into a search or
other reference to the bookmark.

Copy Node
Path to
Clipboard

Select this option to copy the Package's
node path (hierarchy structure) to the
Enterprise Architect clipboard, as a
reference.
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Copy Node
GUID to
Clipboard

Select this option to copy the Package's
node GUID to the Enterprise Architect
clipboard, as a reference.
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Contents Sub-Menu

The 'Contents' sub-menu of the Project Browser Package
context menu provides options for collapsing and expanding
the contents of a Package, bookmarking the elements of a
Package, and restoring the default sort order of the Package.

Access

Context
Menu

Project Browser | Right-click on Package
| Contents

Options

Option Action

Bookmarks Select this option to bookmark all
elements in the selected folder.

Expand
Branch

Select this option to expand the complete
contents of this branch of the Project
Browser.
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Collapse
Branch

Select this option to collapse all items in
this branch of the Project Browser.

Reset Sort
Order

Select this option to return sorting of
Package contents to list the child
elements, child Packages and the contents
of each child Package, in alphabetical
order.

Reload
Current
Package

Select this option to refresh the current
Package in the Project Browser.
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Element Options in the Project
Browser

The element context menu in the Project Browser is
available for all types of element. It provides options for
performing a wide range of operations on both individual
elements and multiple elements, including adding element
properties and features, and moving the element around the
project or between projects.

Access

Context
Menu

Project Browser | Right-click on element

Options (Single element)

Option Description

Specialize Select this option to access two sets of
functions:

Scripts - scripts created using the·

Scripting facility, to be executed on
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elements; click on a script name to
execute it (this option is not shown if
no appropriate scripts have been
created)
Extensions - a list of the enabled·

technologies on the system, each of
which provides options for performing
technology-specific operations on the
element; these options are available in
the Professional, Corporate, Unified
and Ultimate editions of Enterprise
Architect

Collaborate Select this option to display a short menu
of options to exchange electronic notes
on the selected element with team
colleagues, in the form of Reviews,
Discussions and, if User Security is
enabled, Chats and Model Mail
messages.

Properties Select this option to display the element
'Properties' sub-menu, to view and
modify the element properties, notes,
Tagged Values and Linked Document.

Features Select this option to display a short
submenu for managing Attributes and
Operations (both via the Features
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window) and - for a Class element with
attributes - to pre-define initial values for
attributes that can be used to override
existing defaults.
Shortcuts: F9 (Attributes)   F10
(Operations)  Ctrl+Shift+R (Attribute
Initializers)

Add Select this option to access a submenu of
options for creating a child element and
diagram (Classifier elements) or a
connector to another element.

Copy/Paste Select this option to access a menu of
options for copying and moving the
Package contents to other areas of the
model.

Find in all
Diagrams

Locates the element in any diagram that
contains it. If the element is in a single
diagram, the diagram displays. If the
element is not in any diagram, or is in
more than one diagram, the 'Element
Usage' dialog displays. You can select the
diagram containing the instance of the
element you require.
This option also operates on Port and Part
Property Type Classifiers.
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Locate in
Current
Diagram

Select this option to select the element in
the currently-visible diagram.
If the element is not in the diagram, this
option is grayed-out.

Lock Select this option to apply or release a
lock for editing the selected element.
(The option is displayed only when user
security is enabled in User/Group locking
mode)

View Audit
History

Select this option to open the Audit View
to see a history of changes made to the
selected element.

Delete
<element
Name>

Select this option to delete the element.
A prompt displays for you to confirm the
deletion.

Help Select this option to display the Help
topic for the Project Browser.

Options (Multiple elements)

Option Description
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Scripts Lists any scripts created using the
Scripting facility, to be executed on
multiple elements; click on a script name
to execute it (this option is not shown if
no appropriate scripts have been created).

Collaborate This option displays if User Security is
enabled on the model. It provides the
single suboption 'Send Message', which
displays the 'Create Message' dialog to
create and send a message containing a
hyperlink to each of the selected objects.

Print
Diagram(s)

This option enables you to print the
diagram or diagrams that contain the
selected elements.

Generate
Documentati
on

Select this option to display the 'Generate
Documentation' dialog, through which
you can generate a report on the selected
elements.

Copy to
Clipboard

Select this option to copy the selected
elements to the clipboard. You select one
of two sub options:

ID for Pasting as Link - copy the·

element IDs to the clipboard to be
pasted into a diagram as links to the
actual elements (Shortcut: Ctrl+C)
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Full Structure for Duplication - copy·

the elements to the clipboard in XMI
format, for pasting as new duplicate
elements in another Package (Shortcut:
Ctrl+Shift+C)

Delete
selected
item(s)

Select this option to delete the selected
group of objects from the Project
Browser and the model. A prompt
displays for you to select whether to
delete each item in turn (click on the Yes
button) or all items together (click on the
Yes to All button).
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Properties Sub-Menu

The element 'Properties' context menu provides a range of
options for displaying and updating the properties, notes,
Tagged Values and Linked Document of an element, and for
locating the element in any diagrams that contain it.

Access

Context
Menu

Project Browser | Right-click on element |
Properties

Options

Option Description

Properties Displays the Properties window for the
element, which you can use to view and
modify the element properties.

Special
Action

Displays either the 'Properties' dialog for
the element or, for specialized elements,
the dialog that defines their action. For
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example, if this option is selected for a
Checklist Artifact, the 'Checklist Items'
dialog displays for defining the checkbox
items in the list.

Notes Displays the Notes window, showing any
notes that have been written for the
element.

Responsibiliti
es

Displays the Responsibilities window,
through which you can add and update
internal Requirements (Responsibilities),
Scenarios and Constraints on the element.

Tagged
Values

Displays the Tagged Values window,
showing any Tagged Values (extended
properties) that have been created for the
element.

Summary Displays the Summary View of the
selected element, which provides a brief,
read-only summary of the general
properties of the currently selected:

Element (including Packages)·

Attribute·

Operation·

Test·

Maintenance item·
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Resource·

The display refreshes immediately as you
select different objects and items. You
can highlight a section of text or the
complete content, and copy it to be pasted
into an external document.
The Summary View does not display
details for Views, Model Packages,
diagrams, instances or connectors.

Linked
Document

Displays the 'Linked Document' tab of
the Document window showing the
Linked Document for the element, if one
exists.
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Add Sub Menu

The element 'Add' submenu provides a list of appropriate
elements that can be added as child elements to the selected
element. It also provides options for creating child diagrams,
including Composite diagrams, and for adding connectors.

Access

Context
Menu

Project Browser | Right-click on element |
Add

Options

Option Description

Port Select this option to add a Port element to
the border of the selected element.

Composite
Structure
Diagram

Select this option to set the selected
element as a Composite Element and
create a new Composite Structure
diagram (if none exists). If the selected
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element already contains a child diagram,
the existing diagram will instead be
referenced as the element's Composite
diagram.

Select
Composite
Diagram

Select this option to set the selected
element as Composite and link it to a
specified diagram. The linked diagram
could exist anywhere within the current
repository.

Activity Select this option to add an Activity
behavior element and one of its
associated diagrams to the selected
classifier element.

Interaction Select this option to add an Interaction
behavior element and one of its
associated diagrams to the selected
classifier element.

StateMachine Select this option to add a StateMachine
Behavior element and one of its
associated diagrams to the selected
classifier element.

RuleFlow
Activity

Select this option to add a Rule Flow
Activity element and associated diagram
to a Class, in Business Rule Modeling.
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Construction
Diagram

Select this option to create a Construction
rendition of the element on a
Construction diagram. The Construction
rendition is a rectangular element outline
with a  in the bottom right corner, and
compartments automatically enabled; the
compartments show various Project
Management items with Progress Bars
where appropriate, as you define them in
the Construct window.

Add Diagram Select this option to create a diagram to
explain or expand on the selected
classifier element, using the 'New
Diagram' dialog.

Add Custom
Reference

Select this option to set up cross
references between elements in a diagram
and the selected element in the Project
Browser.

Create Link Select this option to create a connector to
another element.

Notes
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Elements such as Actors, Classes and Activities can·

define a large amount of information that can be
conveniently represented by or expanded in a child
diagram; the 'Add' sub-menu for these elements provides
all of the options listed

Elements such as Timing, Exit and History have much·

more specific functions that do not require expansion; the
'Add' sub-menu for these elements only provides the
'Create Link' option
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Element Copy/Paste Submenu

The element 'Copy/Paste' context menu provides a range of
options for copying or moving elements between Packages
or between models, within the Project Browser.

Access

Context
Menu

Project Browser | Right-click on element |
Copy/Paste

Options

Option Description

Copy to
Clipboard

Select this option to copy the selected
element and any sub-structure to the
clipboard. You select one of two sub
options:

ID for Pasting as Link - copy the·

element ID to the clipboard to be
pasted into a diagram as link to the
actual element (Shortcut: Ctrl+C)
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Full Structure for Duplication - copy·

the element(s) to the clipboard in XMI
format, for pasting as new duplicate
elements in another Package (Shortcut:
Ctrl+Shift+C)

Cut Select this option to remove the selected
element from its parent Package, to be
pasted under another element or Package.
The selected element remains where it is
until the Paste operation is invoked.
Shortcut: Ctrl+X

Paste Select this option to paste a cut element
under the selected element or Package. If
the selected element is not a valid target,
the 'Paste' option is grayed out.
(This option is not available for copied
elements - use the 'Paste Package from
Clipboard' menu option in the Package
context menu.)
Shortcut: Ctrl+V

Copy
Documentati
on Bookmark

When using the Legacy Report
Generator, if you want to create a
complex document that consists of
sections of one or more document
reports, rather than one complete report,
you can create a master document in
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Microsoft WordTM and within it create
links to the report sections using their
bookmarks.
Select this menu option to copy the
bookmark to the clipboard, to be pasted
into a search or other reference to the
bookmark.

Paste
Diagram

Select this option to paste an existing
diagram as a child of the selected
element.
The diagram would have been copied to
the clipboard by right-clicking on the
diagram in the Project Browser and
selecting the 'Copy Diagram' menu
option.

Copy Node
Path to
Clipboard

Select this option to copy the Package's
node path (hierarchy structure) to the
Enterprise Architect clipboard, as a
reference.

Copy Node
GUID to
Clipboard

Select this option to copy the Package's
node GUID to the Enterprise Architect
clipboard, as a reference.
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Diagram Menu - Project Browser

The diagram context menu in the Project Browser is
available for all types of diagram. It provides options for
performing a wide range of operations on one diagram or
several diagrams, and for moving a diagram around the
project or between projects.

Access

Context
Menu

Project Browser | Right-click on Diagram

Options

Option Action

Specialize Select this option to access two sets of
options:

Scripts - a list of scripts created using·

the Scripting facility, to be executed on
diagrams; click on a script name to
execute it (this option is not shown if
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no appropriate scripts have been
created)
Extensions - a list of the enabled·

technologies on the system, each of
which provides options for performing
technology-specific operations on the
diagram; these options are available in
the Professional, Corporate, Unified
and Ultimate editions of Enterprise
Architect

Collaborate Select this option to display a short menu
of options to exchange electronic notes
on the selected diagram with team
colleagues, in the form of Reviews,
Discussions and, if User Security is
enabled, Chats and Model Mail
messages.

Properties This option provides access to the
Properties window for the diagram.

Open Select this option to open the diagram in
the Diagram View. (You can also
double-click on the diagram name in the
Project Browser.)

Lock
Diagram

Select this option to display the 'Lock
Diagram' dialog, on which you can set,
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change and release the editing lock on the
selected diagram.

Show
Diagram
Versions

When a diagram is cloned, a custom
reference is added to the diagram (in the
t_xref table). This custom reference
provides information on the clone,
through the 'Show Diagram Version'
dialog.
Select this option to display the 'Show
Diagram Versions' dialog.

Copy / Paste Select this option to access a menu of
options for copying and moving the
diagram to other areas of the model.

Print
Diagram(s)

Select this option to print the
currently-selected diagram or diagrams
(hold Ctrl or Shift while selecting).
The 'Print' dialog displays, on which you
specify the print parameters.
By de-selecting the 'Printable' option on
an element on a diagram, you can omit
that element and its connectors from the
printed diagram.
Shortcut: Ctrl+P

Delete
'<diagram

Select this option to delete the selected
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name>' diagram.
A prompt displays to confirm the
deletion.

Help Select this option to display the Help
topic for the Project Browser.
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Diagram Copy/Paste Menu

The diagram 'Copy/Paste' context menu provides a range of
options for copying or moving diagrams between Packages
or between models, within the Project Browser.

Access

Context
Menu

Project Browser | Right-click on diagram
| Copy/Paste

Options

Option Action

Cut Select this option to remove the selected
diagram from its current location, to be
pasted under another Package or element.
The selected diagram remains where it is
until the 'Paste Diagram' operation is
invoked.
To paste the diagram, use the:

'Copy/Paste | Paste Diagram' option on·
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the Package context menu, or element
context menu

Shortcut: Ctrl+X

Paste Not used.

Copy
Diagram

Select this option to copy the diagram for
pasting into another location.

Copy
Documentati
on Bookmark

When using the Legacy Report
Generator, if you want to create a
complex document that consists of
sections of one or more document
reports, rather than one complete report,
you can create a master document in
Microsoft WordTM and within it create
links to the report sections using their
bookmarks.
Select this menu option to copy a
bookmark on the diagram to the
clipboard, to be pasted into a search or
other reference to the bookmark.

Copy Node
Path to
Clipboard

Select this option to copy the diagram's
node path (hierarchy structure) to the
Enterprise Architect clipboard, as a
reference.

Copy Node Select this option to copy the diagram's
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GUID to
Clipboard

GUID to the Enterprise Architect
clipboard, as a reference.
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Operation or Attribute Menu - Project
Browser

The separate but almost identical 'Operation' and 'Attribute'
context menus in the Project Browser provide options for
performing a number of tasks on the features (operations
and attributes) of an element.

Access

Context
Menu

Project Browser | Right-click on Feature

Options

Option Action

Specialize Provides access to two sets of functions:
Scripts - scripts created using the·

Scripting facility, to be executed on
attributes and operations; click on a
script name to execute it (this option is
not shown if no appropriate scripts
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have been created)
Extensions - a list of the enabled·

technologies on the system, each of
which provides options for performing
technology-specific operations on the
attribute or operation; these options are
available in the Professional,
Corporate, Unified and Ultimate
editions of Enterprise Architect

Collaborate Select this option to display a short menu
of options to exchange electronic notes
on the selected feature with team
colleagues, in the form of Reviews,
Discussions and, if User Security is
enabled, Chats and Model Mail
messages.

Properties Displays a short sub-menu providing
these options:

Properties - Displays the Properties·

window showing details for the
selected feature
Notes - (For attributes) Displays the·

notes recorded on the attribute, in the
Notes window
Tagged Values - (For attributes)·

Displays the Tagged Values recorded
for the attribute, in the Tagged Values
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window
All Features - Displays the Features·

window to access other types of feature
on the same parent element

Copy
Reference

Select this option to copy a reference to
the feature to the Enterprise Architect
clipboard.
Select the appropriate sub-option to copy
the:

Selected hierarchy structure (Node·

Path)
Node GUID·

View Source
Code

Select this option to open the Source
Code Viewer and display the code for the
feature.
Shortcut: F12

Cut Select this option to cut the feature from
its current element and paste it into
another element. The feature does not
move from the original element until you
paste it into the target.
Use the element 'Copy/Paste | Paste'
menu option to paste the feature into its
new parent.
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Paste Not used.

Delete
Attribute /
Operation

Select this option to delete the feature.
The feature is immediately removed from
the element.

Help Select this option to display the Help
topic for the Project Browser.
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Project Browser Icon Overlays

The Project Browser displays the status of each Package in
the model by overlaying status icons on the Package icon.
The meaning of each overlaid icon is provided here.

Icon Overlays

Icon Overlay Indicates that...

This Package is controlled and is
represented by an XMI file on disk;
Version Control either is not being used
or is not available.
You can edit the Package.

This Package is Version Controlled and
checked out to you, therefore you can edit
the Package.

This Package is Version Controlled and
not checked out to you, therefore you
cannot edit the Package (unless you
check the Package out).

This Package is Version Controlled, but
you checked it out whilst not connected
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to the Version Control server.
You can edit the Package but there could
be version conflicts when you check the
Package in again.

This Package is a namespace root, which
denotes where the namespace structure
starts; Packages below this point are
generated as namespaces to code.

The version-controlled Package has been
flagged as Read Only, using a Package
control method applied through the
Automation Interface - as a script, for
example.
The padlock icon displays with other
Package control icons except for the 'blue
box' (third item in the list), which takes
precedence.
The Read Only flag can be applied to
Packages whether they are checked-in or
checked-out.

MDG Add-Ins specify their own icon to
denote that this branch of the model
belongs to that Add-In.
All Packages connected to an MDG
Add-In correspond to a namespace root,
so the namespace root icon is not
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displayed.

Feature Scope

Similarly, the Project Browser indicates attribute and
operation scope status with icons.

Icon Overlay Indicates that...

The attribute or operation is scoped as
protected.

The attribute or operation is scoped as
private.

Notes

In the Corporate, Unified and Ultimate editions, if project·

User Security is on, the Project Browser also has element
locking indicators (red and blue exclamation marks) that
indicate the lock status of individual elements and
Packages
The availability of these elements for editing depends on
whether user locks are required or not

(c) Sparx Systems 2018 Page  72 of 281



User Guide - Model Navigation 21 December, 2018

(c) Sparx Systems 2018 Page  73 of 281



User Guide - Model Navigation 21 December, 2018

Order Package Contents

Ordering elements is very important when it comes to
structuring your model, especially Packages. Report
documents honor any custom ordering when printing
documentation. You can change the order of elements listed
in the Project Browser.

By default, elements are first listed in:

Order of type, then·

Order of set position, then·

Alphabetically·

You can use the Project Browser toolbar arrows to move an
element up or down within its type, but not outside its type.
This means you can re-sequence Packages or diagrams or
Use Cases, but you cannot mix up elements.

However, you can change this default behavior to allow
elements to be re-ordered within the Package, regardless of
type.
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Set Default Behavior

The 'General' page of the 'Preferences' dialog provides
options for altering the behavior of the Project Browser.

Access

Ribbon Start > View > Preferences > General

Options

Panel Option

Project
Browser

Select the appropriate checkboxes to
engage particular facilities in the Project
Browser:

'Confirm Deletes' - This checkbox·

defaults to selected to display a
confirmation prompt whenever you
delete a model component; only clear
the checkbox to bypass the prompt if
you are an experienced user and have
taken other measures to identify and
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recover from accidental deletes
'Allow Free Sorting' - Select this·

checkbox to be able to re-order
elements listed within a Package
regardless of type, in the Project
Browser
'Show Stereotypes' - Select this·

checkbox to display element stereotype
names in front of the element name, in
the Project Browser (you must shut
down and restart Enterprise Architect
for this change in setting to take
effect); you assign a stereotype to an
element in its 'Properties' dialog
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Model Views

The Model Views facility captures information on the
objects in your model from different aspects that you define
yourself, helping you to encapsulate your model under the
areas you are interested in.

Access

Ribbon Show > Portals > Window > Explore >
Model Views or
Start > Explore > Browse > Model Views

Keyboard
Shortcuts

Ctrl+Shift+F5

Features

Feature Detail
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View Root
Nodes

There are three types of View root-node
available:

Model Views - stored in the model and·

visible to all users; you can have many
of these
My Views - stored locally on your·

machine and visible only to you; you
can have only one of these
Technology-defined Views - read only;·

each View is stored with and populated
by the corresponding active MDG
Technology

Additionally, there is a Recent Team
Library folder that contains current
correspondence from the Team Library
concerning items that are held in any of
the Views; this folder has a separate
repository of postings for each Team
Library server connection you access
through the model. You can control how
recent these postings must be, and how
many are to be listed.
When you open the Model Views
window for the first time on a project, a
Model Views root section, My Views
root section and Recent Team Library
folder are added for you. These can not
be deleted or renamed; however, you can
create further Model View root nodes that
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you can modify and delete.

Subordinate
Folders

Under the My Views root node you can
add a single level of View folders, which
enable you to group Search View folders
as best suit your requirements.

A Search View is a folder of elements·

or structures that you assemble by
assigning a model search to the folder;
when you double-click on or expand
the folder, the search runs and refreshes
the folder contents
You can also set a search to refresh at a·

defined interval, and to notify you if
new results are found

Under a Model View root node you can
create Views folders that can contain
Search View folders, Slideshow folders
and Favorites folders.

A Slideshow folder contains diagrams·

only, which you can display as a slide
show with diagrams being shown in the
sequence in which they are listed in the
folder

One folder represents one slide show -
you can run the slide show
automatically or manually; in either
case the diagrams are closed after they
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have been displayed
A Favorites folder gives you easy·

access to commonly-used items in the
Project Browser; to create hyperlinks in
a Favorites folder to the required items
in the Project Browser, drag items from
the Project Browser into the Favorites
folder

You can also export all of the View
folders containing Views from any root
section as an XML file, and import a
Views XML file as an additional, editable
Model View root node.
These are single-level items; if you drag a
Package into the Favorites folder, you
cannot expand that Package there.
To select specific items inside a Package,
expand it in the Project Browser and then
drag the items into the Favorites folder.

Key to Model
View
Contents

Items on the model view can be identified
by their accompanying icons:

 - A Model Views root node
 - A View Folder
 - A Favorites Folder
 - A View (search-based)
 - A Slideshow Folder
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 - The My Views root node
 - The Recent Team Library folder
 - A repository of documents from a

selected Team Library, concerning
elements in the Model Views

 - The recent posts folder for the
selected Team Library
MDG Technologies can define their own
Model Views, in which case they will
display their own technology-specific icon

Accessing
Operations

To perform operations on the Model
View contents, you can use the:

Model Views window Toolbar or the·

Item context menus·

Each level of the Model Views hierarchy
has a slightly different context menu.
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Model Views Toolbar

This material walks through the functions and capabilities of
the Model Views toolbar.

Access

Ribbon Show > Portals > Window > Explore >
Model Views > Toolbar or
Start > Explore > Browse > Model Views
> Toolbar

Keyboard
Shortcuts

Ctrl+Shift+F5 > Toolbar

Toolbar Options

The availability of the Model Views toolbar options depends
on the type of object selected. The options are, from left to
right:

Icon Action
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Click on this icon to display the
appropriate 'Properties' dialog for the
selected item.
Shortcut: Double-click on the item, or
press the Enter key

Click on this icon to locate the selected
object in any diagrams in which it has
been used in the model, and either:

Display the single diagram with the·

object highlighted or
List the several diagrams in which the·

object has been located

Click on this icon to locate and highlight
the selected object in the Project
Browser.

Click on this icon to create a new Model
View root node, and to display the 'New
Model View' dialog in which you enter
the root node name.

Click on this icon to create a new Views
folder in the currently-selected root node.

Click on this icon to create a new
Favorites folder in the currently-selected
Views folder.
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Click on this icon to create a new
Slideshow folder in the currently-selected
Views folder.

Click on this icon to create a new View in
the currently-selected Views folder, and
to display the 'Create New View' dialog
to define the search that populates the
View.

Click on this icon to refresh the selected
Model Views root node, folder, View or
Favorites; for a View, this runs the Model
Search defined in the View properties.

Click on this icon to move the
currently-selected object up or down
within its type; you cannot move - for
example - a Package below a diagram, or
a View above a Favorites folder.

Click on this icon to delete the selected
object and - if appropriate - its contents.
A prompt displays to confirm deletion.
You cannot delete the original Model
Views, My Views or Recent Team
Library root nodes, or any
technology-defined Views.
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Click on this icon to display Help on the
Model Views.

(c) Sparx Systems 2018 Page  85 of 281



User Guide - Model Navigation 21 December, 2018

Model Views Context Menus

This section details the options available from the Model
Views context menu.

Access

Ribbon Show > Portals > Window > Explore >
Model Views : Right-click on object   or
Start > Explore > Browse > Model Views
: Right-click on object

Keyboard
Shortcuts

Ctrl+Shift+F5 : Right-click on object

Options

The Model Views window context menus display different
options, depending on which level of the Model Views
hierarchy you right-click on.

Menu Option Action

Properties (Not for the My Views, Recent Team
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Library, initial Model Views or
Technology-defined root nodes.)
Display the appropriate 'Properties' dialog
for the selected object.
You can edit any of the properties, if
required; changes to objects populated
from the model are reflected in all other
views (Properties window, diagrams,
reports) of that object.
The 'Properties' option for the Documents
and Comments folder displays the
'Recent Post Options' dialog, which
enables you to specify the number of
days back from which to extract postings
from the Team Library, and the number
of postings to list.
The 'Properties' option for a Slideshow
folder displays the 'Slideshow Properties'
dialog, which enables you to automate
the slide show and set the number of
seconds for which each diagram is
displayed.
If you deselect the 'Enable' checkbox, you
must press Spacebar to display each
diagram.

New Views
Folder

(Root node only)
Display a prompt for the Views folder
name and create the folder in the selected
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root node.

Import Views
From XML

(Root node only)
Prompt for the XML file location and
create a new Model Views node to hold
the imported Views.

Export to
XML (Views
Only)

(Root node only)
Prompt for a file path and name, and copy
all Views under the selected root node to
an XML file at that location.

Remove
Model View

(Not for the My Views, initial Model
Views or Technology-defined root nodes)
Display a prompt to delete the selected
user-defined Model View and, if
confirmed, delete the root node and all
contents.

New Search
Folder

(View folder only)
Display the 'Create New View' dialog
(similar to the 'View Properties' dialog)
for you to define the search that populates
the View.

New
Favorites
Folder

(View folder only)
Display the 'Create a new favorites based
folder' dialog, which prompts for the
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folder name.

New
Slideshow

(Model View, View folder only)
Display the 'Create a new slideshow'
dialog, in which you type the name of the
slide show.
You must use the 'Properties' dialog to
define the properties of the slide show.

Open Search (View only)
Display the Model Search screen in the
main work area, listing the full results of
the search and giving access to all the
facilities of the Model Search.
Shortcut: Shift+Space

Refresh Refresh the search and open the View or
Documents and Comments repository to
show the elements or documents
retrieved by the search.
Shortcut: Space

Double Click
Opens Search

Enable you to perform the 'Open Search'
function by double-clicking on the View.
If you deselect this option, double-click
refreshes the search and opens the View
to show the elements retrieved by the
search.
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Edit
Connections

Display the 'Team Documents Server
Connections' dialog, to select which
model to open.

Remove
Folder

(View folder only)
Display a prompt to delete the selected
Views folder and, if confirmed, delete the
folder and all contents.

Remove
View

Display a prompt to delete the selected
View and, if confirmed, delete the View
and all contents.

Remove
Favorites

Display a prompt to delete the selected
Favorites folder and, if confirmed, delete
the folder and all contents.

Remove
Slideshow

Display a prompt to confirm deletion of
the selected slide show and, if confirmed,
delete the slide show and all its diagrams.

Run
Slideshow

Run the slide show in the Diagram View.

Run
Slideshow
Full Screen

Run the slide show in full screen mode,
so that the slide show fills the whole
screen.

(c) Sparx Systems 2018 Page  90 of 281



User Guide - Model Navigation 21 December, 2018

Stop
Slideshow

Cancel execution of the slide show
running in the Diagram View.
Shortcut: Esc

In Project
Browser

(An element, diagram or Package object
only)
Highlight the selected item in the Project
Browser.

In Diagrams (An element or child Package object
only)
Locate the selected object in any
diagrams in which it has been used in the
model, and either:

Display the single diagram with the·

object highlighted or
List the several diagrams in which the·

object has been located

Remove
Linked Item

(An element, diagram or Package object
only)
Display a prompt to delete the selected
object and, if confirmed, remove the
object from the folder.
This has no effect on the object in the
Project Browser or any diagrams.
You would not delete an object in a
View, as it is replaced the next time the
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View is refreshed.

Help Display Help on Model Views.
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Model Views Operations

From the Model Views window you can perform a number
of operations to define the information you extract from the
model and to further process that information, as described
here.

Access

Ribbon Show > Portals > Window > Explore >
Model Views   or
Start > Explore > Browse > Model Views

Keyboard
Shortcuts

Ctrl+Shift+F5

Operations

Operation Detail

Define View
Search

When you:
Create a View, the 'Create New View'·

dialog displays
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Display the View properties, the 'View·

Properties' dialog displays
These dialogs are identical.
In the 'Name' field, type a name for the
View.
In the 'Search' field, either:

Click on the drop-down arrow and·

select an existing search from the lists,
or
Click on the  button to display the·

'Manage Searches' dialog, edit an
existing search or define a new one,
then close the dialog and select that
search name in the 'Search' field

A custom SQL search statement should
return the GUID and type of the object
found so that the system can search for
the selected item in the Project Browser.
The SELECT statement is case-sensitive
and should be typed as shown:
    SELECT ea_guid AS CLASSGUID,
Object_Type AS CLASSTYPE, Name
FROM t_object
If required, in the' Search Term' field type
a specific value to search for.
If you are working with the Corporate or
extended versions of Enterprise
Architect, and you want the search to run
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automatically and refresh the results,
select the 'Refresh this search' checkbox.
The 'Frequency' field has three sections,
for hours, minutes and seconds; click on
the appropriate section and use the up and
down arrows at the end of the field to set
the interval for refreshing the search
results.
You can also set the refresh to display a
pop-up notification if the search results
change. To do this, select the 'Notify me
when new results found' checkbox.
Click on the OK button; the View is
created (or updated) in a collapsed state.
When you expand the View, the search
executes and populates the View.

Display
Recent
Postings

If a new document is added to the Team
Library, or an existing document is
updated, that document is also added
automatically to the Recent Team Library
| <Connection> | Documents and
Comments folder in the Model View.
To open a document, double-click on the
entry; the 'Team Document' tab displays,
showing the selected message.
You can control how many documents
are displayed, and for what period of
time, using the 'Model Views' context
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menu for the Recent Team Library folder.

Move
Objects Into
Favorites

Drag any required Package, diagram or
element from the Project Browser into the
required Favorites folder.

Move
Objects
Between
Views

Views and Favorites folders are fixed in
the Views folder in which you create
them, and you cannot move them.
However, you can:

Copy (by dragging) objects from any·

View into any Favorites folder, and
Move (by dragging) objects between·

any two Favorites folders

Use Objects
From Model
Views

To make use of an element, diagram or
Package held in any View or Favorites
folder, click on the item and drag it into a
diagram or a Team Library posting
The item behaves in the same way as if
you dragged it from the Project Browser.

Create
Documents
containing
Objects

A very useful feature of the Model Views
facility is the ability to drag separate
items from the Views into an existing
Linked Document.
To do this you create your Linked
Document, generate your Model View,
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and open the document and Model View
as docked windows. You then drag the
items - individually or as a multiple
selection - from the View into the
document, selecting one of two options:

'Insert as Hyperlink(s)' and·

'Render as RTF'·

If you select 'Insert as Hyperlink(s)', a
hyperlink is embedded in the document
for each dragged object, linking to the
object in the Project Browser.
If you select 'Render as RTF', a prompt
displays for you to select the RTF
template (if any) from which to generate
a small report on the dragged objects.
You can select different templates for
different objects. However, there must be
compatibility between the selected object
type (such as Diagram) and the RTF
template used (such as Diagram report).
You can have hyperlinked objects and
RTF-rendered objects in the same
document.

Export/Impor
t Views

You export Views to create an XML file
that you can:

Import into another model as a·

user-created Model View or
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Call from an MDG Technology·

Selection (MTS) file to access the
Technology-defined View provided by
the active MDG Technology

The export and import functions are
available from the Model Views
root-node context menus.
When you use the export function, it acts
on the complete set of View folders in the
selected 'My Views' root node, Model
Views root node, or user-generated root
node; you cannot export individual
Views, nor can you export Favorites
folders.
The function displays the 'Save As'
dialog, on which you browse for the
directory location for the exported XML
file, and specify the file name.
When you use the import function, it
displays the 'Select Import Filename'
dialog on which you browse for the
directory and XML file you want to
import; the import creates a new Model
View folder with the same name as the
copied root node.

Set Up a
Technology-
Defined

To set up the Technology-defined View
for an MDG Technology, you:

Create a user-generated Model View in1.
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View Enterprise Architect while using the
technology.
Populate it with the required View2.
folders and Views.
Export the Views from that Model3.
View as an XML file to an appropriate
location.
Create a call to the file from the4.
technology's MTS file.

Thereafter, any model for which the
MDG Technology is active automatically
displays those Views in a
Technology-defined View.
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Diagram Slide Show

The slide show facility in the Model Views window enables
you to create and run screen-based presentations of sets of
diagrams. When you run a slide show, it displays the
diagrams in the folder in the sequence in which they are
listed in the folder. After each diagram has been displayed,
it is closed. You can use this facility to:

Create a slide show as a folder within a Views folder·

under a Model View node

Run a slide show manually·

Run a slide show automatically with each diagram·

displaying for a period that you define

Display a slide show within the Enterprise Architect work·

area

Display a slide show in full screen mode·

Delete a slide show·

Access

Ribbon Show > Portals > Window > Explore >
Model Views   or
Start > Explore > Browse > Model Views

Keyboard Ctrl+Shift+F5
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Shortcuts

Delete a slide show

Ste
p

Action

1 Right-click on the slide show folder and select the
'Remove Slideshow' option.
Enterprise Architect prompts you to confirm the
deletion.

2 Click on the Yes button.
The folder and its list of links to diagrams in the
model is removed.

Run a slide show of diagrams, in either
Diagram View or full screen

Ste
p

Action
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1 Right-click on the slide show folder and select either
the:

'Run Slideshow' option, to run the slideshow in the·

Diagram View
'Run Slideshow Fullscreen' option to run the·

slideshow using the full screen
The first diagram in the slide show displays.

2 If you have set up the slide show to run
automatically, you can leave it to display the
diagrams as defined.
You can also moderate the slide show using manual
commands.

3 If you are controlling the slide show manually,
right-click on a slide.
This toolbar displays:

4 Control the slide show using these toolbar icons and
other aids:

Display the next slide - , (Spacebar) or (→)·

Display the previous slide - , (←)·

Display the first slide - , (↑)·

Display the final slide - , (↓)·

Pause the slide show - ·

Resume the slide show - ·
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Stop the slide show -  or, in Diagram View,·

right-click on the slide show folder and select the
'Stop Slideshow' option

Define how the slide show is to operate -
automated or manual

Ste
p

Action

1 Right-click on the slide show folder and select the
'Properties' option.
The 'Slideshow Properties' dialog displays.

2 To automate the slide show, select the 'Enable'
checkbox.
To run the slide show manually, deselect the
checkbox.

3 If you are automating the slide show, in the 'Time'
field type the number of seconds that each diagram
is to remain on display.

4 Click on the OK button.
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Create a slide show

Ste
p

Action

1 Under a Model Views node, click on the Views
folder to contain the slide show.

2 Either:
Right-click on the Views folder and select the·

'New Slideshow' option or
Click on the 'New Slideshow folder' icon in the·

Model Views toolbar
The 'Create a New Slideshow Folder' dialog
displays.

3 In the 'Name' field, type the name of the slide show.

4 Click on the OK button.
The new slide show folder is added to the selected
View folder.

5 Dock the Project Browser window separately from
the Model Views window.
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6 Drag the diagrams to be displayed as part of the slide
show from the Project Browser into the new slide
show folder.
Organize the diagrams in the order in which they are
to be displayed, using the up/down green arrows in
the Model Views toolbar.
To remove a diagram that is not required, right-click
on it in the slide show folder and select the 'Remove
Linked Item' option.
The diagram items in the slide show folder are links
to the diagrams in the Project Browser, not copies of
the diagrams or the diagrams themselves; any
actions you take in the slide show have no impact on
the original diagrams.

7 Close the folder.
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Package Browser

If you want to quickly create and operate on elements in a
Package, you can use the Package Browser as a workbench.
The Package Browser is a tabular, editable view of the
elements in a selected Package, which can be displayed
either in the main View or as a floating window, and as
either a List display or a Gantt chart. It can be particularly
useful for setting up a Package for a specific purpose, such
as when an Analyst creates and maintains formal
requirement definitions within the model. When you have
checked the contents of the Package, you can either print the
list of elements or generate a document report on all or a
subset of the elements.

You can open more than one instance of the Package
Browser, to review different Packages at the same time.
Each instance of the Package Browser is a separate window,
identified by the Package name.

The Package Browser is related to, and can be used in
conjunction with, the:

Diagram List, which lists the elements in a selected·

diagram, and

Specification Manager, which is a document-based·

interface to the Package, providing the means of creating
and reviewing elements as text representations of model
objects in that Package
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Access

Ribbon Design > Package > List
Design > Package > Gantt

Context
Menu

Right-click on Package | Open Package in
| List View
Right-click on Package | Open Package in
| Gantt View

Keyboard
Shortcuts

Ctrl+Alt+R    (view as list)

Features

Feature Detail

Select List
View or
Gantt View

When you select one of these menu paths,
you select either the List View of the
Package Browser, or the Gantt View.

List View lists all the elements in the·

Package, with their properties; you can
manipulate this display using various
menu options
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Gantt View lists all the elements in the·

Package, grouped by model hierarchy,
but showing the work timeline for each
element and for each resource assigned
to work on the element, and the
percent-completion of all tasks
associated with each element

Once you have displayed one of these
views, you can switch to the other by
right-clicking on the display and selecting
the appropriate context menu option:

Switch to List View or·

Switch to Gantt View·

Switch List
View
Formats

The Package Browser has a separate
version of the Navigator toolbar, through
which you can change the Package being
investigated and, in 'List View', the
content shown.
In 'List View', the Package Browser has
two formats that influence the use of
other options on the display:

User Defined format, initially a flat list,·

where you can define how the element
information is grouped on the screen
using the value-grouping band below
the toolbar
Hierarchy format, where the elements·

are already organized into their
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Package and element hierarchies in the
display (the value-grouping band is
disabled)

To set the format, click on the  icon in
the toolbar and select (for Hierarchy
format) or deselect (for User Defined
format) the 'Show Element Hierarchy'
option.

Change
Standard
View display

It is possible to reorganize the
information in the Package Browser in a
number of ways:

In User Defined format, sort the items·

by any column value in ascending or
descending order, by clicking on the
column header; initially the elements
are listed in numerical order (if level
numbering is turned on in the Project
Browser) or alphabetical order within
type
Change the sequence of columns by·

dragging column headers left or right
In Hierarchy format, the 'Name'·

column is always on the left; you
cannot move any other column into that
position, although you can rearrange
the sequence of the rest of the columns

Because of this, if you group or sort
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information in User Defined format
and switch to Hierarchy format your
information structure is altered, and it
is not restored when you switch back to
User Defined format

Show
Elements in a
Child
Package

Double-click on the child Package in the
list to re-focus the display, showing the
contents of that Package only.

Display
Element
Properties

Double-click on the element line to
display the element 'Properties' dialog, or
press Ctrl+Enter.
If the Properties window is open, click on
any element to make it the focus of the
Properties window.

Select Items Select:
An element by clicking on it·

A specific value by clicking twice on it·

(not double-clicking); either the value
becomes directly editable (overtype or
select from drop-down) or the
'Properties' dialog displays in which
you can edit the value
Several individual elements by holding·

Ctrl as you click on them
A range of elements by holding Shift as·
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you click on the first and last in the
range

Add new
items to the
Package

Click on a listed element and press
Ctrl+N or the Insert key, or right-click
and select the 'Add New Element' option.
The 'New Element' dialog displays;
complete the fields and click on the
Create button.

In Model Hierarchy format, the new·

element is inserted as a sibling of the
selected element, in its parent Package
In User Defined format, the new·

element is added to the root Package
selected for display in the Package
Browser

Add a child
element to
the selected
element

Click on the selected element and press
Ctrl+Shift+N.
The 'New Element' dialog displays;
complete the fields and click on the
Create button.

In Model Hierarchy format, the new·

element is inserted as a child of the
selected element
In User Defined format, the new·

element is added to the root Package
selected for display in the Package
Browser
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Add elements
to the
Package
Browser

Drag the required elements from
anywhere in the Project Browser. The
element is listed in the Package Browser,
and moved into the target Package in the
Project Browser.
You can also drag elements from the
Package Browser into a Package in the
Project Browser, in either List view or
Gantt view.

Add elements
to a diagram
from the
Package
Browser

In either List view or Gantt view, you can
drag one or more elements from the
Package Browser onto a diagram to
immediately create an instance of each
element on the diagram (and in the
Project Browser for the diagram's parent
Package).
Click each element (pressing Ctrl or Shift
for multiple selections) to select it before
dragging it onto the diagram.
One advantage of dragging elements
from the Gantt view is that it provides the
additional filter on task or resource, so
that you can isolate elements to be copied
to a diagram or Package specific to a task
or resource.

Delete Select the item and press Ctrl+D. This
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elements
from the list

deletes the element from all diagrams and
from the model itself.
In Model Hierarchy format, you cannot
delete a parent element until all its child
elements have been removed or deleted.

Include each
element's
notes
(documentati
on)

Notes are shown underneath the element.
To add or edit notes, click on the item
and press Ctrl+Shift+Space to transfer
control to the Notes window, in which
you create or edit the note text.
Alternatively, right-click on the element
line and select the 'Edit Notes' option.

Further Work You can do further work on the Package
Browser using the toolbar and context
menu options.
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List Header

In your work on your project you might use any of a number
of 'listing' reports in which information is organized in
several columns. Such reports include the:

Package Browser·

Specification Manager·

Diagram List·

Model Search·

Model Mail view·

'Feature' dialog, 'Attributes' and 'Operations' pages·

'Find Toolbox Item' dialog in the Diagram Toolbox·

'Testing' and 'Maintenance' tabs of the 'QA Reports and·

Metrics' view

The Gantt View·

The Project Management windows·

In these reports, you can quickly and easily reorganize the
sequence and combination of columns to present the
information in the most appropriate format to suit your
needs, and filter the data according to the values of the text
strings displayed in the column fields.

Reorganize layout of display

Tool Description
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View Header

The View Header defines the columns of
information that are presented by the
report, and the order in which data items
are presented.
To review the column headings:

Right-click on the header and select the·

'Field Chooser' option; the 'Field
Chooser' dialog displays

You can use this dialog to add columns to
or remove columns from the output;
between them, the View Header and
'Field Chooser' dialog show the full range
of column headers available.
To add a column heading to the View
Header:

Drag it from the 'Field Chooser' dialog·

onto the header to the position you
want the column of data to display
When you have selected the column·

headings you require, click on the red
cross in the top right corner of the
'Field Chooser' dialog to close it

To remove a column from the output:
Drag the column heading downwards·

out of the View Header
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To change the sequence of columns:
Drag the required column header left or·

right, as appropriate

Value
Grouping

For most reports, if the Package Browser
or Diagram List does not have the 'Show
Element Hierarchy' option selected, you
can organize the reported data according
to the value of one or more of the column
categories, as identified in the 'Group
Box' above the column headings. If the
'Group Box' is not already displayed,
right-click on the column headings and
select the 'Enable Group Box' option.
You might organize the data by 'Type',
and within each 'Type' by 'Name'; if you
then click on any other column heading,
the data within this grouping is further
sorted with the values of the selected
column (for example, 'Created') in
ascending or descending order.
To set up the value grouping, drag the
column heading representing the primary
grouping (such as 'Author') into the
'Group Box'.
Now drag the column heading for the
next level of grouping (such as 'Status') to
the right of the first heading; the two
heading titles display as connected
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blocks, as shown:

You can, if required, add further levels of
grouping by dragging other column
headings onto the hierarchy (such as
'Created'), and restructure the order by
dragging existing or additional headings
into the level you want them to hold.
For example, you could make 'Type' the
secondary grouping by dragging it to the
right of 'Author', or drop 'Status' between
'Author' and 'Type'.
To remove a grouping level, drag the
appropriate column heading out of the
sequence and below the View header; any
subordinate groupings move up a level.

Filter Bar The Filter Bar displays underneath the
column headings; you can hide or show it
using the 'Toggle Filter Bar' context menu
option on the column headings.
The Filter Bar consists of a row of fields,
one field per column; as you type a value
into one of these fields, the item lists are
automatically filtered to show entries
with a value in the corresponding column
that contain the text string in the field.
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For example:
If you type the letter 'F' in the Filter Bar·

field under the 'Author' column, the
results immediately reduce to entries
for which the letter 'F' occurs anywhere
in the name (Fred, Fitzgibbon, Rufus,
Wolf)
If you then go on to type 'Fi', the results·

immediately reduce again to entries for
which the combination 'fi' appears in
the name (Fitzgibbon, Amalfi)

For reports and displays that identify the
percentage completion of a task or piece
of work, you can specify a percentage
value or a range to display items that
match that value. In the Filter Bar, in the
field under the '%Completed or
Complete' field, type:

<x to display items less than x percent·

complete; for example, <30 (all items
less than 30 percent complete, but not
those exactly 30 percent complete)
>x to display items more than x percent·

complete; for example, >30 (all items
more than 30 percent complete, but not
those exactly 30 percent complete)
x to display items exactly x percent·

complete; for example, 30 (all items
exactly 30 percent complete)
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-x to display items exactly x percent·

complete and less than that; for
example, -30 (all items less than 30
percent complete and those exactly 30
percent complete)
x- to display items exactly x percent·

complete and more than that; for
example, + 30 (all items more than 30
percent complete and those exactly 30
percent complete)
x-y to display items between x-1·

percent complete and y+1 percent
complete; for example 30-45 (all items
between 30 and 45 percent complete,
including those exactly 30 percent and
45 percent complete)
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Package Browser Options

In building and managing your model you can use the
Package Browser as a workbench to perform many
operations, such as reorganizing the Package structure,
adding new Packages and elements, and generating reports
on the Package contents. You can also modify the display in
a number of ways.

To perform all of these operations, you select options from
the drop-down menu available through the  icon on the
Package Browser toolbar or through the context menu.

Access

Toolbar Package Browser List View toolbar : 

Context
Menu

Right-click on Package Browser List
View

Menu Options

Option Action
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Add New Add a new element to the Package.
The 'New Element' dialog displays.
Shortcut: Ctrl+N

Edit Notes Display the Notes window, to add or edit
notes for the selected element. The cursor
is positioned at the start of the text entry
area of the window.
Shortcut: Ctrl+Shift+Space

Print Print the current contents of the Package
Browser.
The 'Print' dialog displays, on which you
specify the print job.

Generate
Report

Display the 'Generate Documentation'
dialog, to create one document report on
the selected element(s). You can apply
the full facilities of this dialog to tailor
the report to your requirements.

Show Nested
Package
Content

Toggle the display between:
Including child Packages and their·

contents in the list, and
Showing only the first-level contents of·

the selected diagram or Package

Show Toggle the display between:
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Element
Hierarchy

Hierarchy format and·

User-Defined, value-grouping format·

Show Filter
Bar

Display or hide the Filter Bar fields
underneath the column headings, in any
of which you can type a text string to
filter the data in the corresponding
column to show only data containing the
typed string.

Show Group
Bar

Display or hide the Group Bar (Drag a
column header here to group by that
column).

Note Options Display a short menu from which you can
select to:

Hide the contents of the Notes·

compartment of each element
Display the first few words as a·

preview, or
Display the full text of each note·

Context Menu Options

Right-click on an item in the list of elements and Packages.
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Option Description

Properties Display the 'Properties' dialog for the
selected element.

Edit Notes Add or edit notes on the element, in the
Notes window.
Shortcut: Ctrl+Shift+Space

Create
Linked
Document (E
dit Linked
Document)

Create (or edit) a Linked Document.
(Corporate, Unified and Ultimate
editions.)
Shortcut: Ctrl+Alt+D

Delete
Linked
Document

(If the element has a Linked Document.)
Delete the existing Linked Document.

Add New
Element

The 'New Element' dialog displays,
through which you create an element of
any type (after setting the appropriate
toolset).

Find in
Diagrams

Display:
The diagram that uses the element, or·

If the element is used in multiple·

diagrams, the 'Element Usage' dialog,
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which lists the diagrams that contain
the element

Find In
Project
Browser

Highlight the selected element in the
Project Browser.

Bookmark
Item

Bookmark the element.

Switch to
Gantt View

If in Standard (or List) View format,
switch the display to Gantt View format.

Documentati
on

Generate a document report; you have
two options:

Generate a separate report on each·

selected object in the report
Generate one report on all selected·

objects
In either case, the 'Generate
Documentation' dialog displays. If you
have selected to generate separate reports,
the 'Generate Documentation' dialog
displays separately for each report in
turn.
You also have the option to print the
Package Browser list itself.

In Hierarchy format, synchronize the list
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Sort Contents with the Project Browser hierarchy, to
ensure that all element and Package
hierarchies and sequences are - if
necessary - updated.
Normally changes are updated
automatically, but there can be delays if
changes are made outside the Package
Browser.

Reload Reload the list of elements to refresh the
order and content with any recent
changes.

Add Tag
Value
Column

Add a column to show the values for a
selected Tagged Value, for each element
in the list (see Add Tagged Value
Column).

Columns
Layout

Preserve, apply or delete a profile of the
column layout of the Package Browser
display. A layout consists of the number
of columns and (where the workstation
screen layout permits) the column widths.
When you mouse-over this option, a
submenu displays:

Load Columns Layout - displays a·

dialog in which you select to apply the
default layout (all possible columns) or
one that you have previously saved;
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click on the OK button to apply the
layout
Save Columns Layout - displays a·

dialog in which you specify the name
under which to save the layout - you
can replace an existing layout by
clicking on the drop-down list and
selecting the name, or save as a new
layout by typing a new name
Delete Columns Layout - displays a·

dialog in which you specify the layout
profile to delete; when you click on the
OK button, the profile is deleted (and
cannot be retrieved again) but if that
profile was in use when it was deleted,
the layout persists until it is specifically
changed, even if you close and re-open
the Package Browser

Print Print the contents of the Package
Browser.
The 'Print' dialog displays, on which you
specify the print job.

Delete
Selected

Delete the selected element from the
Package Browser.
A confirmatory prompt displays; click on
the Yes button.
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Add Tagged Value Column

If you want to show the value that any element in the list has
for a particular tag, you can add a read-only column for the
tag. There are two ways in which to do this:

Method Action

1 Open the Tagged Values window for the
element and drag the tag onto the
Package Browser; a new column is added
for each tag you drag onto the list.

2 Either:
Right-click on the element in the·

Package Browser or Diagram List, or
Right-click on the column headings·

Then select the 'Add Tag Value Column'
option; the 'Add Tag Value Column'
dialog displays.
Either type the tag name into the 'Tagged
Value' field, or select one of the two
options:

Global Tagged Values - populates the·

'Tagged Value' drop-down list with all
global Tagged Values in the project;
this enables you to select a Tagged
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Value that is applicable to a large
number of elements
Tagged Values from the selected·

element - populates the 'Tagged Value'
drop-down list with the Tagged Values
defined for the selected element (as
listed on the Tagged Values window
for that element); this enables you to
filter the initial selection to a specific
set of tags

When you have selected the required tag,
click on the OK button to insert a column
for that tag into the Package Browser or
Diagram List header.

Notes

In the Corporate, Unified and Ultimate editions of·

Enterprise Architect, if Auditing is turned on and the
Package Browser is open, you can view a history of
changes to any selected element or connector, in the
'Audit History' tab of the System Output window (if
Security is enabled, you must have at least 'Audit View'
permissions to display the audit history)
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Search: Finding Information

Enterprise Architect has a powerful and easy to use search
facility that helps you to find elements in a model, based on
any criteria including name, the date of creation or
modification, type, textual notes and more. There are a
number of built in searches, but even a novice user can
easily extend the functionality by defining powerful and
parameterized searches that can be stored and rerun. When
run, the searches return a set of elements that can be located
within the hierarchy of the repository or in any diagrams in
which they appear; they can even be included in reports.
This powerful feature ensures that, regardless of the
structure of the Project Browser or how large the repository
is, you will always be able to locate the information you are
looking for.

Facilities

Facility

Model Search - how to use the searching capability within
Enterprise Architect to find and display various kinds of
information
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Create and Modify Searches - how to modify and work
with search definitions

Adding Filters - further modifications to searches

Diagram Filters- how to suppress or highlight information
in a diagram using customizable filtering mechanisms
based on element properties such as status and complexity
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Model Search

The Model Search facility helps you to quickly navigate to
or find modeling elements within your model. It lists each
object that meets the search criteria you specify within the
search terms and search type. Many different kinds of
searches are already built into the system, and it is possible
to create detailed and specific searches of your own. It is
also possible to export and share your favorite searches.
Having obtained the results of a Model Search, you can
perform a range of operations on them to either modify their
presentation or to extract and/or report on further levels of
detail.

You specify, run and manage the model searches through
the toolbar at the top of the view.

Access

Ribbon Start > Explore > Search > Model
Design > Element > Edit > Search Model

Keyboard
Shortcuts

Ctrl+F   or
Ctrl+Alt+A
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Specify a Search

Option Action
Search
Category Use the default Common Searches group

to filter the types of search you might
select from, to the commonest searches
used.
If you want to use a search from a
different functional set, including
searches you have created or imported
yourself, click on the drop-down arrow
and select the appropriate group.
Individual searches you have created are
contained in the My Searches group.
Searches imported as part of a
Technology are grouped under the
Technology name.

Search
Simple is the first, and most general, of
the system-supplied searches in the
Common Searches group. If you want to
execute a different search in this group,
click on the drop-down arrow and select
the search from the list.
The drop-down list is populated from the
search group selected in the first field in
the toolbar. To list and execute different
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searches, change the group in the first
field.

Search Term
Type in the word, phrase or characters to
search on.

Search in
Model Click on this icon to run the selected

search using the search term you have
provided.

New Search
Click on this icon to display the 'New
Search' dialog, through which you can
create your own search in the My
Searches group.

Copy Search
If you want to copy an existing search to
edit into a new search, select the existing
search and click on this icon.
The Enter Search Name prompt displays,
in which you type a new name for the
copied search. The search is
automatically copied into the My
Searches group.
You can now edit this copy to suit your
requirements.

Edit Search
After creating a new or copied search,
you can edit the search definition.
Click on this icon to open the Query
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Editor underneath the toolbar. You can
use search filters to modify the searches
on a search term in order to locate model
elements having specific characteristics.

Delete
Search Click on this icon to delete the search

definition from the My Search group and
its associated Search drop-down list.
The icon is not available for system
defined searches or technology-defined
searches.

Documentati
on and QA Click on this icon to display a submenu

of these options for acting on the results
of a Model Search:

Edit Notes - select this option to open·

the Notes window to edit the text of
any notes a selected element might
have
Generate Documentation - select this·

option to display the 'Generate
Documentation' dialog, through which
you can generate a report on one or
more selected items from the search
results
CSV Import/Export - select this option·

to specify the CSV export file location
into which to export the search results
View Notes - select this option to·
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specify whether to:
    - Hide the text of any Notes each
item might have
    - Display a summary (the first line)
of any Notes each item might have
    - Display the full text of any Notes
each item might have
Import Search - select this option to·

display the 'Windows Directory
Explorer Open' dialog, to import
searches as XML Search files from an
external directory; these searches
would have been exported from
another user's model or project
Export Search - select this option to·

display the 'Export Searches' dialog, on
which you select the checkbox against
each search in your model that you
want to export to an external directory
as an XML Search file; other users can
then import this file into their models,
to make the same searches available to
them
Dock in Output Bar - select this option·

to move the 'Find in Project' tab to the
System Output window
Dock in Main View - select this option·

to return the 'Find in Project' tab to the
main view in the center of the screen
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Result List
The results of the search display in the
view area, under a set of column headings
that you can reduce, add to and rearrange
to better display the information you
need.
You can also operate on the items in the
search results using the Model Search
context menu.

Keyboard Options

When the search has produced results, you can perform a
number of simple operations on them using the keyboard
keys:

Display the 'Properties' dialog for the element·

(double-click or press the Enter key)

Drag item(s) onto a diagram (Ctrl+drag selected items) - a·

prompt displays for you to specify how to render the
element on the diagram

Open the Linked Document window for the selected·

element (Ctrl+Alt+D)

Notes
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You can access the Model Search facilities and perform·

specific searches indirectly, from Add-Ins, from MDG
Technologies, from a hyperlink and from a shortcut to
access your model; this entails setting up a search profile
either in the appropriate tool, or as an XML file accessed
by the tool

Searching from

An MDG Technology

A Login Shortcut

An Add-In

A Hyperlink
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Pre-defined Searches

Enterprise Architect provides a range of pre-defined
searches, grouped according to type. Each search is briefly
explained here.

Access

Ribbon Start > Explore > Search > Model
Design > Element > Edit > Search Model

Keyboard
Shortcuts

Ctrl+F   or
Ctrl+Alt+A

Other There are many points throughout
Enterprise Architect where you can
invoke a specific pre-defined search,
either to execute immediately without
input from you, or to display the Find in
Project view where you enter a search
term before executing the search. For
example, the 'Start > Explore > Search >
Diagram', or 'Package' ribbon options.
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Common Searches

Search Description

Simple Searches the 'Name', 'Alias' and 'Notes'
fields of all elements for the given search
term.

Extended Searches many additional fields relating
to the element, including Attributes,
Operations, Tagged Values and Test
Cases.

Element
Name

Searches for an exact match against the
element name, alias, method or operation;
the default search in the 'Search in Model'
menu option in the Code Editor.

Attribute
Details

Searches for elements with attributes
relating to the search term, including
Tagged Values, constraints, and common
attribute data fields.

Method
Details

Searches for elements with operations
and methods relating to the search term,
including Tagged Values, constraints and
common operation and method data
fields.
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Recently
Modified
Elements

Searches for elements that have been
recently modified, anywhere in the
project.
The search term relates to any common
element field.
The default is to show elements modified
in the last three days, but you can set an
alternative interval by typing the
appropriate number of days in the 'Search
Term' field.

Find
Operations
by Name

Searches for the use of a named operation
anywhere in the model.

Find
Attributes by
Name

Searches for the use of a named attribute
anywhere in the model.

Find Package Searches for a named Package in the
model.

Find
Scenarios

Lists all elements in the project
containing defined scenarios.

Schema
Profiles

Lists all elements containing Schema
Profiles held in the project. You can filter
the list by element name, in the 'Search
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String' field.

Recently
Modified
Schema
Profiles

Locates all elements in the project
containing Schema Profiles modified
within the previous n days; you specify n
in the 'Search String' field.

Recently
Modified
Linked
Documents

Locates all elements in the project
containing Linked Documents modified
within the previous n days; you specify n
in the search string field.

Recently
Modified
Decision
Tables

Locates all elements in the project
containing Decision Tables modified
within the previous n days; you specify n
in the search string field.

Linked
Documents

Lists all elements in the project having
Linked Documents and having the search
term in the element name.

Decision
Tables

Locates all elements containing Decision
Tables in the project.

Find
Baselines

Lists all Packages having Baselines in the
project.
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Diagram Searches

Search Description

Find Orphans Searches for orphaned elements
throughout the model, with the ability to
filter on common element fields using a
search term.
An 'orphaned' element is an element that
does not appear on any diagram in the
model.

Find
Bookmarked
Elements

Searches for elements that have been
bookmarked, anywhere in the project.

Recently
Modified
Diagrams

Searches for diagrams that have been
recently modified, anywhere in the
project.
The search term relates to any common
diagram properties field.
The default is to show diagrams modified
in the last three days, but you can set an
alternative interval by typing the
appropriate number of days in the 'Search
Term' field.

Diagram Lists the diagrams that have the value
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Details specified in the 'Search Term' field in one
or more of the diagram details fields.

Diagram
Name

Lists the diagrams that have a name
containing the term specified in the
'Search Term' field.

Find Kanban
Diagrams

Lists all Kanban diagrams in the model
and identifies who created them, when
they were created and when they were
last modified.

Test and Verification Searches

Search Description

Failed
Internal Tests

Searches the project for elements
containing one or more internal test cases
where the 'Status' value is 'Fail' and the
search term is in any common Test Case
field.
The output lists the elements and shows
their properties; use the 'Construct >
Testing > Test Windows > All' ribbon
option to examine the test records for a
selected element.
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Tests on
Recently
Modified
Elements

Searches the project for recently modified
elements that have test records. In the
'Search Term' field you can specify the
number of days over which to check
back. If you do not specify a number of
days, the search uses a value of 1 day.
The output lists the elements that have
test records and that have been modified
during the specified period, and shows
the details of each test record on each
element. Double-click on an item to
display the 'Test Details' dialog for that
test.

Tests Not
Run

Searches the project for elements having
test records where the 'Status value' is any
of: 'Not Run', 'Cancelled' or 'Deferred'. In
the 'Search Term' field you can specify
the number of days over which to check
back. If you do not specify a number of
days, the search uses a value of 1 day.
The output lists the elements that have
test records that have:

Been updated during the specified·

period and
Have a status other than 'Pass' or 'Fail'·

The output shows the details of each test
record on each element. Double-click on
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the item to display the 'Test Details'
dialog for the test.

Tests Not
Checked

Searches the project for elements having
test records that have no 'Checked By'
value. In the 'Search Term' field you can
specify the number of days over which to
check back. If you do not specify a
number of days, the search uses a value
of 1 day.
The output lists the elements that have
test records that have:

Been updated during the specified·

period and
Have an empty 'Checked By' field·

The output shows the details of each test
record on each element. Double-click on
the item to display the 'Test Details'
dialog for the test.

Passed Tests Searches the project for elements having
test records where the 'Status' value is
'Pass'. In the 'Search Term' field you can
specify the number of days over which to
check back. If you do not specify a
number of days, the search uses a value
of 1 day.
The output lists the elements that have
test records that have:
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Been updated during the specified·

period and
Have the status 'Pass'·

The output shows the details of each test
record on each element. Double-click on
the item to display the 'Test Details'
dialog for the test.

Failed Tests Searches the project for elements having
test records where the 'Status' value is
'Fail'. In the 'Search Term' field you can
specify the number of days over which to
check back. If you do not specify a
number of days, the search uses a value
of 1 day.
The output lists the elements that have
test records that have:

Been updated during the specified·

period and
Have the status 'Fail'·

The output shows the details of each test
record on each element. Double-click on
the item to display the 'Test Details'
dialog for the test.

Deferred
Tests

Searches the project for elements having
test records where the 'Status' value is
'Deferred'. In the 'Search Term' field you
can specify the number of days over
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which to check back. If you do not
specify a number of days, the search uses
a value of 1 day.
The output lists the elements that have
test records that have:

Been updated during the specified·

period and
Have the status 'Deferred'·

The output shows the details of each test
record on each element. Double-click on
the item to display the 'Test Details'
dialog for the test.

Recently Run
Tests

Searches the project for elements having
test records where the 'Run Date' field has
a value. In the 'Search Term' field you
can specify the number of days over
which to check back. If you do not
specify a number of days, the search uses
a value of 1 day.
The output lists the elements that have
test records that have a 'Run Date' value
within the specified period, and shows
the details of each test record on each
element. Double-click on the item to
display the 'Test Details' dialog for the
test.
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Requirements

Search Description

Internal
Requirements

Searches the project for elements with
internal requirements where the search
term relates to any common requirement
field.
The output lists the elements that have
requirements containing the search term
value, and shows the element properties.
To review the requirements, double-click
on an item to display the element
'Properties' dialog and select the
'Requirements' page.

Requirements Searches the project for Requirement
element types where the search term
occurs in any common element field.
The output lists the Requirement
elements containing the search term.
Double-click on an item to display the
'Properties' dialog for that element.

Recently
Discussed

Searches the project for any element that
has a recent entry in the Collaborate
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Elements window. In the 'Search Term' field you
can specify the number of days over
which to check back. If you do not
specify a number of days, the search uses
a value of 3 days.
The output lists the elements that have
recent discussions, and their properties.
You can display the discussions
themselves by selecting the 'Start >
Collaborate > Discussions > Discuss'
ribbon option and clicking on the
individual entries in the search output.

Recent
Element
Posts

Searches the project for any element that
has a recent entry in the Collaborate
window. In the 'Search Term' field you
can specify the number of days over
which to check back. If you do not
specify a number of days, the search uses
a value of 3 days.
The output lists the elements that have
recent discussions, and the date of the
most recent post on each element. You
can display the discussions themselves by
selecting the 'Start > Collaborate >
Discussions > Discuss' ribbon option and
clicking on the individual entries in the
search output.
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Resource Tracking

Search Description

Resources Searches the project for elements with
assigned resources, where the search term
is the value of any common Resource
field.
The output lists all elements with
assigned resources containing the text
string specified as the search term, and
shows the properties of each element. To
see the assigned resources for an element,
click on the item and select the 'Construct
> Task Management > Resource
Allocation' ribbon option.

Tasks
Overdue

Searches the project for elements with
assigned resources, where the end date is
in the past and the percentage completion
is less than 100.
The output lists all elements with overdue
tasks, and shows the details of the
resource allocation to each task.

Active Tasks Searches the project for elements with
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assigned resources, where the end date is
in the future and the percentage
completion is less than 100.
The output lists all elements with
currently active tasks, and shows the
details of the resource allocation to each
task.

Tasks
Completed

Searches the project for elements with
assigned resources, where the percentage
completion is 100.
The output lists all elements with
completed tasks, and shows the details of
the resource allocation to each task.

Recently
Finished
Tasks

Searches the project for elements with
assigned resources, where the end date is
in the recent past and the percentage
completion is 100. In the 'Search Term'
field, specify the number of days over
which to check back.
The output lists all elements with tasks
completed within the specified period,
and shows the details of the resource
allocation to that task. The output does
not include tasks that have already been
finished in advance of a future
completion date.
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Tasks Ending
Today

Searches the project for elements with
assigned resources, where the task end
date is today.
The output lists all elements with tasks
ending today, whether the task is
complete or not, and shows the details of
the resource allocation to each task.

Tasks
Starting
Today

Searches the project for elements with
assigned resources, where the task start
date is today.
The output lists all elements with tasks
starting today, and shows the details of
the resource allocation to each task.

Authors with
no Active
Tasks

Searches the project for authors who have
not been assigned as a resource to any
task that is currently active.
The output lists all defined authors who
have not been assigned to any task that:

Is currently less than 100 percent·

complete or
Has a start date that is not in the future·

30-Day Task
Summary
(Simplified)

Provides a brief summary of the work
allocated to each resource over the last 30
days - how many tasks, how much time
they took and how much time they were
expected to take. Tasks can be grouped
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into Series, so a resource might have
more than one entry in the report,
summarizing the work for each series.

30-Day Task
Summary
(Full)

Provides a brief summary of the work
allocated to the resources over the last 30
days, in order of task Group Name. There
can be many entries for each resource,
depending on the tasks and task groups
they have been allocated to.

30 Day
Resources

Provides a breakdown of each resource
allocation record created or updated
during the last 30 days. If you specify
search text, the report shows records
where the text is included in the resource
name.

30 Day Roles Provides a breakdown of each resource
allocation record created or updated
during the last 30 days. If you specify
search text, the report shows records
where the text is included in the role
name.

Project Status
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Search Description

My Checked
Out Packages

Searches the project for Packages under
Version Control that are marked as
checked out under your user ID.

Simulation

Search Description

StateMachine
Diagrams

Lists all StateMachine diagrams that exist
in the current model, and their properties.

Activity
Diagrams

Lists all Activity diagrams that exist in
the current model, and their properties.

Recent
StateMachine
Diagrams

Lists all StateMachine diagrams that you
have opened recently.
The default is to show diagrams opened
in the last seven days, but you can set an
alternative interval by typing the
appropriate number of days in the 'Search
Term' field.
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Recent
Activity
Diagrams

Lists all Activity diagrams that you have
opened recently.
The default is to show diagrams modified
in the last seven days, but you can set an
alternative interval by typing the
appropriate number of days in the 'Search
Term' field.

Executable
StateMachine
s

Lists all Executable StateMachine
elements (Artifacts with the <<executable
statemachine>> stereotype) in the project,
with their element properties.

SysMLSim
Configuratio
n

Lists all SysMLSim Configuration
elements (Artifacts with the
<<SysMLSimConfiguration>>
stereotype) in the project, with their
element properties.

BPSim
Report

Lists all the simulation report results (as
BPSim Result Artifacts) in the project,
with their element properties.

BPSim Chart Lists all BPSim Chart elements (both
standard and customized) in the project,
with their element properties.

BPSim Lists all BPSim elements (Artifacts with
the <<BPSim>> stereotype) in the

(c) Sparx Systems 2018 Page 155 of 281



User Guide - Model Navigation 21 December, 2018

project, with their element properties.

Changes

Search Description

Verified
Changes

Lists the elements in the project having
internal change records that have the
status 'Verified' and that are not
completed.

Recently
Requested
Changes

Lists the elements having change records
for recent requests that might or might
not have been acted on. In the 'Search
term' field type the number of days
previous to check (the report defaults to
7).

Recently
Completed
Changes

Lists the elements having change records
that were given the status 'Complete'
recently. In the 'Search term' field type
the number of days previous to check (the
report defaults to 7).

New
Changes

Lists the elements having change records
that have the status 'New' (that is, no
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action has been taken on them yet).

Incomplete
Changes

Lists the elements having change records
that do not have the status 'Complete'.

Defects

Search Description

Verified
Defects

Lists the elements in the project having
internal defect records that have the status
'Verified' and that are not completed.

Recently
Reported
Defects

Lists the elements having recently
reported defect records that might or
might not have been acted on. In the
'Search term' field type the number of
days previous to check (the report
defaults to 7).

Recently
Resolved
Defects

Lists the elements having recently
resolved defect records that were given
the status 'Complete'. In the 'Search term'
field type the number of days previous to
check (the report defaults to 7).
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New Defects Lists the elements having defect records
that have the status 'New' (that is, no
action has been taken on them yet).

Unresolved
Defects

Lists the elements having defect records
that do not have the status 'Complete'.

Issues

Search Description

Verified
Issues

Lists the elements in the project having
internal issue records that have the status
'Verified' and that are not completed.

Recently
Reported
Issues

Lists the elements having recently
reported issue records that might or might
not have been acted on. In the 'Search
term' field type the number of days
previous to check (the report defaults to
7).

Recently
Resolved
Issues

Lists the elements having recently
completed issue records that were given
the status 'Complete'. In the 'Search term'
field type the number of days previous to
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check (the report defaults to 7).

New Issues Lists the elements having issue records
that have the status 'New' (that is, no
action has been taken on them yet).

Unresolved
Issues

Lists the elements having issue records
that do not have the status 'Complete'.

Tasks

Search Description

Verified
Tasks

Lists the elements in the project having
internal task records that have the status
'Verified' and that are not completed.

Recently
Requested
Tasks

Lists the elements having recently
requested task records that might or
might not have been acted on. In the
'Search term' field type the number of
days previous to check (the report
defaults to 7).

Recently
Completed

Lists the elements having recently
completed task records that were given
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Tasks the status 'Complete'. In the 'Search term'
field type the number of days previous to
check (the report defaults to 7).

New Tasks Lists the elements having task records
with the status 'New' (that is, no action
has been taken on them yet).

Incomplete
Tasks

Lists the elements having task records
that do not have the status 'Complete'.

Events

Search Description

Recently
Reported
Events

Lists the elements having recently created
event records that might or might not
have been acted on. In the 'Search term'
field type the number of days previous to
check (the report defaults to 7).

Recently
Completed
Events

Lists the elements having recently
resolved event records (the 'Resolved'
checkbox is selected). In the 'Search term'
field type the number of days previous to
check (the report defaults to 7).
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High Priority
Events

Lists the elements having event records
with a 'Priority' setting of 'High', that
have not been resolved.

Open Events Lists the elements having event records
that have not been resolved or completed.

Decisions

Search Description

Verified
Decisions

Lists the elements in the project having
internal decision records that have the
status 'Verified' and that are not
completed.

Recently
Created
Decisions

Lists the elements having
recently-created records for decisions that
might or might not have been acted on. In
the 'Search term' field type the number of
days previous to check (the report
defaults to 7).

Recently
Effective

Lists the elements having records for
decisions that have recently become
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Decisions effective. In the 'Search term' field type
the number of days previous to check (the
report defaults to 7).

New
Decisions

Lists the elements having decision
records that have the status 'New' (that is,
no action has been taken on them yet).

Unresolved
Decisions

Lists the elements having decision
records that do not have the status
'Complete'.

Test Points

Search Description

Test Suites Lists the Test Suite elements that exist in
the model. Type a text string in the
Search Term field to filter for Test Suite
elements with that string in the element
name.

Test Sets Lists the Test Set elements that exist in
the model. Type a text string in the
Search Term field to filter for Test Set
elements with that string in the element
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name.

Test Cuts Lists the Test Cut elements that exist in
the model. Type a text string in the
Search Term field to filter for Test Cut
elements with that string in the element
name.

Database Engineering

Search Description

Data Models Searches the project for data model
Packages (Packages with the string
'DataModel' in the 'Stereotype' field).
The output lists the DataModel Packages
with their basic properties.

Database
Objects

Searches the project for database objects;
that is, Class elements with any of the
database object stereotypes. You can
filter the list by specifying one of the
stereotypes in the 'Search Term' field, or a
text string to match text in the 'Alias',
'Name' or 'Notes' fields.
The output lists the database object

(c) Sparx Systems 2018 Page 163 of 281



User Guide - Model Navigation 21 December, 2018

elements with their element properties.

Functions Searches the project for database
Functions; that is, Class elements with
the string 'function' in the 'Stereotype'
field. You can filter the list by specifying
a text string in the 'Search Term' field, to
match text in the 'Alias', 'Name' or 'Notes'
fields.
The output lists the database Function
elements with their element properties.

Procedures Searches the project for database
Procedures; that is, Class elements with
the string 'procedure' in the 'Stereotype'
field. You can filter the list by specifying
a text string in the 'Search Term' field, to
match text in the 'Alias', 'Name' or 'Notes'
fields.
The output lists the database Procedure
elements with their element properties.

Sequences Searches the project for database
Sequences; that is, Class elements with
the string 'sequence' in the 'Stereotype'
field. You can filter the list by specifying
a text string in the 'Search Term' field, to
match text in the 'Alias', 'Name' or 'Notes'
fields.
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The output lists the database Sequence
elements with their element properties.

Table
Column
Datatypes

Searches the project for database Tables
that have data types containing the string
you specify in the 'Search Term' field.
This field must contain a value.
The output lists Table elements that have
data types containing the specified string,
and shows the element properties of each
Table.
To see the data types, double-click on the
item to display its 'Properties' dialog,
click on the 'Table Detail' tab and on the
Columns button, and review the data
types of the columns on the 'Columns and
Constraints' dialog.

Table
Columns

Searches the project for database Table
columns that contain the string you
specify in the 'Search Term' field. This
field must contain a value.
The output lists Table elements that have
columns containing the specified string,
and shows the element properties of each
Table.
To see the columns, double-click on the
item to display its 'Properties' dialog,
click on the 'Table Detail' tab and on the
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Columns button, and review the columns
on the 'Columns and Constraints' dialog.

Table
Foreign Keys

Searches the project for database Tables
that have Foreign Keys (constraints). You
can filter the search by specifying a text
string in the 'Search Term' field.
The output lists Table elements that have
Foreign Keys, and shows the element
properties of each Table.
To see the Foreign Keys, double-click on
the item to display its 'Properties' dialog,
click on the 'Table Detail' tab and on the
Constraints button, and review the
constraints of type FK on the 'Columns
and Constraints' dialog.

Table
Indexes

Searches the project for database Tables
that have Indexes (constraints). You can
filter the search by specifying a text
string in the 'Search Term' field.
The output lists Table elements that have
Indexes, and shows the element
properties of each Table.
To see the Indexes, double-click on the
item to display its 'Properties' dialog,
click on the 'Table Detail' tab and on the
Constraints button, and review the
constraints of type Index on the 'Columns
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and Constraints' dialog.

Table
Primary Keys

Searches the project for database Tables
that have Primary Keys (constraints).
You can filter the search by specifying a
text string in the 'Search Term' field.
The output lists Table elements that have
Primary Keys, and shows the element
properties of each Table.
To see the Primary Keys, double-click on
the item to display its 'Properties' dialog,
click on the 'Table Detail' tab and on the
Constraints button, and review the
constraints of type PK on the 'Columns
and Constraints' dialog.

Tables Searches the project for database Tables;
that is, Class elements with the string
'table' in the 'Stereotype' field. You can
filter the list by specifying a text string in
the 'Search Term' field, to match text in
the 'Alias', 'Name' or 'Notes' fields.
The output lists the database Table
elements with their element properties.

Triggers Searches the project for Table Trigger
elements. You can filter the list by
specifying a text string in the 'Search
Term' field, to match text in the 'Alias',
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'Name' or 'Notes' fields.
The output lists the Table Trigger
elements with their element properties.

Views Searches the project for database Views;
that is, Class elements with the string
'view' in the 'Stereotype' field. You can
filter the list by specifying a text string in
the 'Search Term' field, to match text in
the 'Alias', 'Name' or 'Notes' fields.
The output lists the database View
elements with their element properties.
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Create Search Definitions

If you want to define your own searches, you can do so
using the SQL Editor, Query Builder or an Add-In, through
the 'New Search' dialog. User-defined searches are stored in
the user application data for the machine being used, and not
in the project repository.

Access

Ribbon Start > Explore > Search > Model : 
or
Design > Element > Edit > Search Model
: 

Keyboard
Shortcuts

Crtl+F :   or
Ctrl+Alt+A : 

Create a new search definition

Field/Button Action

Name Type a name for the search.
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Query
Builder

Click on this radio button to create your
search through the internal search editor.

SQL Editor Click on this radio button to create your
search by directly writing SQL
statements.
(For advanced users.)

Add-In
Search

Click on this radio button to define the
search as a function of an Add-In.

Add-In Name
and Method

(Available if you have selected the
'Add-In Search' radio button)
Type in:

The name of your Add-In·

A period (full stop) and·

The name of the method to be called·

whenever the search is run (for
example, MyAddin.RunThisMethod);
this search can be exported and
distributed as a part of your Add-In

OK Click on this button to create the new
search and close the dialog.
The search builder panel opens
underneath the toolbar. For:

An Add-In search, no further action is·
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required; click on the  icon to close
the search builder panel
A Query Builder search, the panel·

defaults to the 'Query Builder' tab and
you can start adding filters and
constructing the search; see the Define
and Modify Searches topic
An SQL search, the panel defaults to·

the 'Query Builder' tab and you can
start to create the SQL statement for
the search, as in Create SQL Search

The Search Builder also provides an 'SQL
Scratch Pad' tab, which you can use to
create and test SQL statements before
copying them across to the 'Query
Builder' tab.
SQL statements on the 'SQL Scratch Pad'
are not attached to any search and are not
the focus of any operations initiated from
the 'Find in Project' toolbar.

Cancel Click on this button to abort the search
creation and close the dialog.

Create SQL Search
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You can create SQL statements using the SQL Editor
through the 'Query Builder' tab. The SQL editor is based on
the common Code Editor, and provides an Intelli-sense
autocompletion list populated from the Enterprise Architect
repository structure.

To display the autocompletion list, position the cursor after
a command and press Ctrl+Spacebar.

A simple search might be to locate an object from a table,
given a search term that the user enters in the 'Search Term'
field, such as:

    SELECT * FROM t_object WHERE NAME='<Search
Term>'

In the WHERE statements you can also use #xxx# macros
as string replacers, so that the same search can be used by
different people in different environments. These macros are
all case-sensitive. They include:

Macro Description

#Author# Takes the user name from the 'Author'
field in the 'Preferences' dialog 'General'
page, so the defined search can be
performed on objects created by that user
(this value can be manually re-set in the
'Preferences' dialog).

#Branch# Gets the IDs of the child Packages of the
currently-selected Package, working
recursively down to the lowest level of
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sub-Package. For example:
t_object.Package_ID IN (#Branch#)·

#Concat
value1,
value2 ...#

Provides a method of concatenating two
or more SQL terms into one string,
independent of the database type.

#Datepart
<field>,
column#

Provides a method of querying one part
of the Date, independent of the database
type. The value of <field> can be one of:

year·

month·

day·

dayofyear·

weekday·

week·

dayname·

#CurentElem
entGUID#

Gets the ea_guid for the
currently-selected element. For example:

t_object.ea_guid LIKE·

#CurrentElementGUID#

#CurrentEle
mentID#

Gets the Object_ID for the currently
selected element. For example:

t_object.Object_ID=#CurrentElementI·

D#
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#DB=<DBN
AME>#

<DBNAME> can be one of:
MYSQL·

JET·

ACCESS2007·

ORACLE·

SQLSVR·

ASA·

POSTGRES·

FIREBIRD·

This only uses the section of code
between two matching
#DB=<DBNAME># macros if the
current database type matches the
specified DBNAME; it can be used
where a section of the SQL might require
special handling depending upon the
current database type. For example:
    #DB=ORACLE#
t_object.ModifiedDate >= (SYSDATE -
INTERVAL '<Search Term>' DAY)
#DB=ORACLE#

#Now# Inserts the current date plus or minus a
specified number of hours or days; the
default is days (the date format is
adjusted to suit the database in use) as in:

t_object.ModifiedDate >=#Now·

<Search Term>#
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For example:
t_object.ModifiedDate >= #Now -4d#·

d is days
t_object.ModifiedDate >= #Now -5h#·

h is hours
t_object.ModifiedDate >= #Now +3#·

t_object.ModifiedDate >= #Now#·

#Package# Gets the Package_ID for the
currently-selected Package. For example:
    t_object.Package_ID = #Package#

#UserName# Gets the name of the person logged into
Version Control. This example is from
the built in search 'My Checked Out
Packages'.

t_package.PackageFlags LIKE·

'#WC#VCCFG=#WC#CheckedOutTo
=#UserName##WC#'

#WC# Gets the appropriate wild card for the
current database, so the search can be
performed on models on different
databases. For example:
    t_object.Name LIKE
'#WC#Test#WC#'
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The GUID and Type

For all functions in which you use a custom SQL statement
(including Document Reporting and Model Views) the
statement must return the guid and type of the object found
so that the system can search for the selected item in the
Project Browser. The SELECT statement is case-sensitive
and should be typed as shown:

SELECT ea_guid AS CLASSGUID, Object_Type AS·

CLASSTYPE, Name FROM t_object

You can extend the usability of your SQL searches using the
aliases CLASSGUID and CLASSTYPE, so that you can
display the 'Properties' dialog, Tagged Values and icon for
elements, connectors, attributes or operations, as well as
selecting them in the Project Browser. Some simple
examples for using these aliased fields are:

SELECT ea_guid AS CLASSGUID, Object_Type AS·

CLASSTYPE, Name FROM t_object

SELECT ea_guid AS CLASSGUID, 'Operation' AS·

CLASSTYPE, Name FROM t_operation

SELECT ea_guid AS CLASSGUID, 'Attribute' AS·

CLASSTYPE, Name FROM t_attribute

Queries for connectors and diagrams can both return types
that match the default association to object types. For these
tables, you should also return a CLASSTABLE field to
allow them to be distinguished from the similar object type.

SELECT ea_guid AS CLASSGUID, Connector_Type AS·
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CLASSTYPE, 't_connector' as CLASSTABLE, Name
FROM t_connector

SELECT ea_guid AS CLASSGUID, Diagram_Type AS·

CLASSTYPE, 't_diagram' as CLASSTABLE, Name
FROM t_diagram

You can enable your search users to drag and drop elements
from the search results onto a diagram, by including one of
these in your search SELECT statement:

(t_object.Object_ID and t_object.Object_Type) or·

t_object. ea_guid AS CLASSGUID·

When you have defined the SELECT statement, click on the
Save button in the 'Query Builder' toolbar to save this
search; the search is then available from the 'Search'
drop-down list.

SQL Scratch Pad Toolbar buttons

The 'SQL Scratch Pad' tab provides a small number of
facilities through its toolbar.

Icon Description

Click on this icon to test the search you
have defined. The results display in the
main panel of the 'Find in Project' view.

Click on this icon to save the current SQL
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search as a new search. A prompt
displays for the new search name.
When you click on the OK button, the
system switches to the 'Query Builder'
tab, copies the SQL Statement to the tab,
and puts the search name into the 'Search'
field.

Click on this icon to clear the 'SQL
Scratch Pad' of the current search
definition.

Notes

When you create a custom SQL search on the 'Query·

Builder' tab, the only two icons that are available in the
Toolbar are the Save icon and the Remove Filter icon ;
the Remove Filter icon is effectively a Delete icon that
removes the search content (the SQL statement)
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Define & Modify Searches

Having created a new Query Builder search, you can define
the actions of the search using a series of filters on the
'Query Builder' tab of the search editor. A filter is a
statement instructing the search to extract objects of a
certain type with a specific property having a specific value
or a value within a defined range. You can have a number of
filters within one search. If you have copied an existing
search as a base for the new search, the tab will contain
filters already. If the search is completely new, the tab will
be empty.

You build up the search definition in two areas:

The 'Add Filters' dialog, where you can configure the·

filters to whatever level of precision you require

The 'Query Builder' tab, where you can modify the filter·

settings, define how specific a part of the model to search,
and test the search

Access

Ribbon Start > Explore > Search > Model |
<select search> :  > Query Builder or
Design > Element > Edit > Search Model
| <select search> :  > Query Builder
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Keyboard
Shortcuts

Crtl+F | <select search> :  > Query
Builder or
Ctrl+Alt+A | <select search> :  >
Query Builder

Build a Search

Ste
p

Action

1 Click on the  ('Add Filter') icon to display the 'Add
Filters' dialog, and select and define a set of filters.
If you already have filters in the search, you can add
others of the same filter set by selecting the filter set
label (such as 'Attribute') before you click on the
icon. The filter items are then refined to that filter set
on the 'Add Filters' dialog.

2 If necessary (for example, if you are modifying a
copy of an existing search) remove selected filter
items. Click on either the filter itself or the filter set
heading and click on the  (Remove Filter) icon.

If you selected a filter item, it is immediately·

removed
If you selected the filter set heading, a prompt·
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displays to confirm the deletion; when you click
on the Yes button, all filters in the set are removed

3 If you have edited a system-provided search prior to
saving it as your own search, and you have decided
that the changes are not appropriate, you can 'roll
back' to the original settings. Click on the 
(Restore Default) icon in the toolbar.

4 Click on the  ('Search Options') icon to set the
level of the model to search, and the interaction of
the filters.

Edit Search on Query Builder tab

On the 'Query Builder' tab, you can activate, deactivate and
modify the individual filters within the search. This is
especially useful for 'tweaking' the search as you test it.

Column Action

Search In If the Search contains many filters in a
number of filter sets, you can collapse the
filter sets you don't want to review, and
expand those you do. Click on the
expansion box (  ) next to the filter set
name, as necessary.
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Click on the checkbox next to an object
property to select it for inclusion in the
search, or clear it and omit it from the
search.

Condition If you want to change the condition that
the property value must satisfy, click
twice on the field to display the
drop-down list and select the new
Condition.
The available options are 'Contains',
'Equal To', 'Not Equals' and 'One Of'.

Look for In most cases, this field is initially set to
<Search Term> to accept a value that the
search user types into the 'Search Term'
field.
If necessary, overtype the current value
with one or more specific values to
perform the conditional search on.
This value should match the selected
filter type; for example, the value would
be a date for 'DateCreated' or a text value
for 'Name'.
The search term can consist of multiple
values, separated by commas.

Required Select the checkbox to indicate whether
the field is mandatory - that is, whether
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the search results must only include
elements with your search term in that
field.
These examples show uses of the
'Required' checkbox in the default Simple
search, which checks the 'Name', 'Alias'
and 'Notes' fields of all elements:

If the 'Required' checkbox is not·

selected for any field, then if the search
term is found in the 'Name', 'Alias' OR
'Notes' field for an element, that
element is listed in the results
If the 'Required' checkbox is ticked for·

all fields in the search, then the search
term must be found in all of those
fields before the element is listed in the
results; that is: 'Name' AND 'Alias'
AND 'Notes'
If the 'Required' checkbox is ticked for·

some fields but not others, the search
term must be found in all fields for
which the checkbox is ticked, and at
least one of the fields in which the
checkbox is not ticked; that is: Name
AND (Alias OR Notes)

These checkboxes help you to define the
filters on a specific feature (such as
Element, Diagram or Attribute). You can
also set up a filter to check for a defined

(c) Sparx Systems 2018 Page 183 of 281



User Guide - Model Navigation 21 December, 2018

value in every feature included in a
search (an AND filter) or in any feature
included in the search (an OR filter).

Notes

When you have set up your search, click on the Save·

Search icon in the Query Builder toolbar and then the 
(Search in Model) icon to run the search and test it
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Add Filters

A filter is a statement instructing a search to extract objects
of a certain type with a specific property having a specific
value or a value within a defined set. You can add a number
of filters to a Model Search or Document Generation, to
more precisely define the objects or information to extract
from the model.

Access

Filters can be applied to a model search, and also to
document generation to filter the elements that are reported
on.

Model
Search

In search window | <select search> :  |
Query Builder : 

Document
Generation

In 'Generate Documentation' dialog |
Element Filters : Add Filter

Add filter criteria to a model search or a
document report template
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Option Action

Active Filter
Set

Click on the drop-down arrow and select
the type of object to search for. Initially,
when there are no other filters selected,
the drop-down list provides the full range
of top-level objects.

The object type defines the filter set and
once you have selected the object type
the drop-down list subsequently only
includes objects subordinate to that set.
For example:

If the initial selection is set to search on·

'Element', the drop-down list for
subsequent filters on the search will
show a list of element properties that
you can filter more specifically on
If the initial filter is set to search on·

'Diagram', the list for any subsequent
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filters for the search only contains the
'Diagram' option, as there are no other
filters that can be applied to a search on
diagrams

Add Filter Select the checkbox corresponding to
each field that the search is to evaluate.

Required Select the checkbox if the object must
have this property to be included in the
search results.

Field Provides the name of the field to be
checked in the search.

Condition Click on the drop-down arrow and select
the condition that the field value has to
satisfy. That is, the field value:

Contains·

Is exactly Equal to·

Is anything other than (Not Equals) or·

Is one of a subset of values from·

the text string in the '<Search Term>'
field for the search, or a more specific
value defined in the 'Value' field.

Value If the search is to look for a value
provided by the person running the
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search, leave this field at the default value
of '<Search Term>'.
Otherwise over-type the field with a
specific value or, if the 'Condition' is 'One
Of...', type a selection of values separated
by commas.
For some filters and conditions, the
'Value' field contains the  button. Click
on this to display a selection dialog. This
dialog varies dependant on the
information required.

Check All Click on this button to select all of the
'Add Filter' checkboxes to include all
filters in the search definition.
You might then deselect specific
checkboxes to remove a small number of
filters from the search.

Uncheck All Click on this button to clear all selected
'Add Filter' checkboxes to omit all filters
from the search definition.
You might then select specific
checkboxes to include only a small
number of filters in the search.

OK Click on this button to apply the filters to
the search definition.
The selected filters are displayed in the
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'Query Builder' tab for the search
definition.

Cancel Click on this button to close the dialog
and cancel the changes you have made.

Notes

You can add multiple search definitions as necessary;·

however, if you select the 'Required' field in multiple
definitions the search rapidly becomes impractical

Multiple search definitions are better for 'and/or' searches·
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Advanced Search Options

The advanced search options help you to apply greater
control over how your customized search operates on your
model.

You can set values and checkboxes in your search definition
to find specific criteria within a feature, for example,
element properties. However, you can also set filters to run
the search across the whole model or a specific Package,
and to locate objects that have a specified value in:

All features (for example, the value exists in an element's·

properties and one of its attributes' properties) or

Any one of its features (for example, the value exists in an·

element's properties or any of its attributes' properties)

The filters for each feature operate on a database table. In
the system-supplied searches, for example, filters on
element properties operate on the t_element table, filters on
attribute properties operate on t_attribute, and filters on
method parameters operate on t_operationparams.

Access

From the 'Find in Project' Search window, select a search,
then click on the  icon in the Search window toolbar,
select the 'Query Builder' tab, then click on the  icon in
the Query Builder toolbar.
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Other <select search> :  | Query Builder : 

Options

Option Action

Return
matching
items for the
entire model

Defaults to selected, to run the search
across the entire model.
The search checks every Package in the
model, and returns items that match the
search criteria from wherever they are
located.

Return
matching
items for the
selected
Package

Click on this radio button to run the
search on a specific Package that the user
selects in the Project Browser.
If the user runs a search and then selects a
different Package in the Project Browser,
the search results do not change until they
click on the Search in Model icon again;
that is, to search different areas of the
project:

Click on the first required Package in·

the Project Browser
Click on the Search in Model icon·
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Check the result·

Click on another Package in the Project·

Browser
Click on the Search in Model icon·

All Tables Click on this radio button to list objects
that have a match in every feature table
checked in the search.
For example, only list elements where
both the element and one or more of its
attributes have the same stereotype name.

At Least One
Table

Defaults to selected to list objects that
have a match in at least one of the feature
tables checked in the search.
For example, list elements that either
have the specified stereotype name, or
have attributes that have the specified
stereotype name.

OK Click on this button to apply the settings
and close the dialog.

Cancel Click on this button to cancel any
changes you have made and close the
dialog.
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Customizing the Search View

After you have executed a search and displayed a list of
results, you can reorganize the display to show items in a
different sequence, add or remove columns for particular
characteristics, group the items according to one or more
characteristics, and/or select various items from the results.

Access

Ribbon Start > Explore > Search > Model >
Results pane or
Design > Element > Edit > Search Model
> Results pane

Keyboard
Shortcuts

Crtl+F > Results pane  or
Ctrl+Alt+A > Results pane

Reorganization Options

Option Detail

Sort and In the Model Search you can:
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Select Sort the items by any column value in·

ascending or descending order, by
clicking on the column header and on
the blue arrowhead at the right of that
header
For a system-supplied search, display·

the properties of a selected item of any
type, by double-clicking on the item
Select:·

    - An item by clicking on it
    - Several individual items by holding
Ctrl as you click on them
    - A range of items by holding Shift
as you click on the first and last
       in the range
    - All items in the list by pressing
Ctrl+Shift+Alt+A

Change and
Resequence
Columns
using the
View Header

The View Header defines the columns of
information that are presented by the
Model Search, and the order in which
data items are presented.
To review the column headings:

Right-click on the header and select the·

'Field Chooser' option; the 'Field
Chooser' dialog displays
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From this dialog, you can add columns to
or remove columns from the output;
between them, the View Header and
'Field Chooser' dialog show the full range
of column headers available.
To add a column heading to the View
Header:

Drag it from the 'Field Chooser' dialog·

onto the header to the position you
want the column of data to display in
When you have selected the column·

headings you require, click on the red
cross in the top right corner of the
'Field Chooser' dialog to close it

To remove a column from the output:
Drag the column heading downwards·

out of the View Header
To change the sequence of columns:

Drag the required column header left or·

right, as appropriate

Value
Grouping

You can organize the reported data
hierarchically according to the value of
one or more of the column categories.
You might organize the data by 'Type',
and within each 'Type' by 'Name'; if you
then click on any of the other column
headings, the data within this grouping is
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further sorted with the values of the
selected column (for example, 'Created')
in ascending or descending order.
To set up the value grouping, drag the
column heading representing the primary
grouping (such as 'Author') onto the 'Drag
a column header here to group by that
column' field.
Now drag the column heading for the
next level of grouping (such as 'Status') to
the right of the first heading; the two
heading titles display as connected
blocks, as shown:

You can, if required, add further levels of
grouping by dragging other column
headings onto the hierarchy (such as
'Created'), and restructure the order by
dragging existing or additional headings
into the level you want them to hold.
For example, you could make 'Type' the
secondary grouping by dragging it to the
right of 'Author', or drop 'Status' between
'Author' and 'Type'.
To remove a grouping level, drag the
appropriate column heading out of the
sequence and below the View header; any
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subordinate groupings move up a level.
When you have a report with grouped
results, you can toggle between the
expanded hierarchy and the collapsed
(top-level item only) grouping by
right-clicking on the View Header and
clicking on the 'Collapse All' option.

Filter Bar The Filter Bar displays underneath the
column headings; you can hide or show it
by right-clicking on the column headings
and clicking on the 'Toggle Filter Bar'
option.
The Filter Bar consists of a row of fields,
one field per column; as you type a value
into one of these fields, the Model Search
results are automatically filtered to show
entries in the corresponding column that
contain the value in the field.
For example:

If you type the letter 'F' in the Filter Bar·

field under the 'Author' column, the
results immediately reduce to entries
for which the letter 'F' occurs anywhere
in the name (Fred, Fitzgibbon, Rufus,
Wolf)
If you then go on to type 'Fi', the results·

immediately reduce again to entries for
which the combination 'fi' appears in
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the name (Fitzgibbon, Amalfi)
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Model Search Context Menu

You can select elements or diagrams in the results of a
Model Search and perform various operations on them, as
well as simply dragging the item into a Team Library
document or Linked Document. You can:

Generate reports from search results·

Print search results·

Copy and work with search results·

Manage elements returned by a search·

For Packages that are presented in the search results, you
can also select an option to open the Package in the
Specification Manager.

Access

Context
Menu

When you have executed a search,
right-click on an item in the search results

Menu Options

Option Action
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Scripts Click on this option to display a list of
any Model Search scripts you have
created, which can be executed on the
selected item.
This option displays only if:

You have created Model Search scripts·

in a Model Search Script Group folder,
and
The item results from a successful·

Query search, or
The item results from a successful SQL·

search that includes CLASSGUID and
CLASSTYPE

Properties Click on this option to display the
'Properties' dialog for the element.

Copy
Selected to
Clipboard

Click on this option to copy the selected
item to the MS Windows clipboard so
that it can be pasted as a link into a
diagram, document, spreadsheet or email.
Shortcut: Ctrl+C

Documentati
on

Click on this option to generate a
document report on the selected item(s);
you have two options:

'Generate a separate report on each·
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selected object in the Model Search'
'Generate one report on all selected·

objects'
In either case, the 'Generate
Documentation' dialog displays.
If you generate the report using a custom
SQL search, the SQL must include
'ea_guid AS CLASSGUID' and the object
type.

Create
Linked
Document
(Edit Linked
Document)

Click on this option to create (or edit) a
Linked Document on the selected
element.
(Available in the Corporate, Unified and
Ultimate editions).
Shortcut: Ctrl+Alt+D

Delete
Linked
Document

Click on this option to delete an existing
Linked Document.
(This option only displays if the element
has a Linked Document.)
A prompt displays to confirm the
deletion. Click on the Yes button.

Print Click on this option to print out the
results as currently displayed.
The 'Print' dialog displays, on which you
select the printer and define the print run.
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Clear Results Click on this option to clear the search
results from the display.

Find in
Diagrams

Click on this option to display the
diagram that depicts the element or, if the
element is used in multiple diagrams,
display a list of diagrams to choose from.

Find in
Project
Browser

Click on this option to highlight the
element in the Project Browser.
(Some reportable objects are not shown
in the Project Browser; if you select one
of these, this option is not available.)

Specification
Manager

(For a selected Package in the search
results.) Click on this option to open the
Specification Manager and display the
Package contents in it.
If you generate the report using a custom
SQL search, the SQL must include
'ea_guid AS CLASSGUID and
Object_Type AS CLASSTYPE' in order
for the Specification Manager to display
the Package.

Bookmark
Item

Click on this option to add or clear a
bookmark on the element.
A small dialog displays on which you
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select the appropriate radio button to set
the bookmark on or off. If you set the
bookmark on, a red triangle (or red Delta
symbol) is displayed on the element icon
in the results. If you clear the bookmark,
the red triangle is removed.

Delete
Selected

Click on this option to delete the selected
element from the Model Search results.
A prompt displays to confirm the
deletion; click on the Yes button.

Help Display the Help topic on the Model
Search.

Add Items To Linked Document

A very useful feature of the Model Search facility is the
ability to drag separate items from the Search results into an
existing Linked Document.

To do this you create your Linked Document, run the Model
Search, and open the document and Model Search view as
docked windows. You then drag the items - individually or
as a multiple selection - from the search results into the
document. You are prompted to select one of two options:

'Insert as Hyperlink(s)' and·
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'Render as RTF'·

If you select 'Insert as Hyperlink(s)', a hyperlink is
embedded in the document for each dragged object, linking
to the object in the Project Browser.

If you select 'Render as RTF', a prompt displays for you to
select the RTF template (if any) from which to generate a
small report on the dragged objects. You can select different
templates for different objects. However, there must be
compatibility between the selected object type (such as
Diagram) and the RTF template used (such as Diagram
report), otherwise nothing is shown in the document.

You can have hyperlinked objects and RTF-rendered objects
in the same document.

Notes

Running a custom or diagram-based search disables some·

context menu options
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Traceability

A repository contains a graph of elements connected by
relationships; traceability is the ability to explore this graph
from a particular starting point in any direction. Modelers
commonly think of traceability as just applying to
requirements, and the ability to find which elements in the
model realize (implement) the requirements; the term is,
however, much broader than this and can be applied to any
model element. The requirements, for example, could be
traced to stakeholders, which in turn could be traced to a set
of drivers and goals, and these could be traced to a set of
regulatory constraints. Enterprise Architect provides flexible
and expressive features that help you to explore and traverse
this graph of connections, including the Traceability
Window and the Relationship Matrix. Enterprise Architect
extends the UML by allowing users to trace between model
features such as attributes and operations, which is a
powerful mechanism for the analyst.

Traceability Tools

Enterprise Architect provides a number of tools for tracing
the definition and implementation of a process, from initial
requirement to generated code or technical deployment, or
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vice versa. Such tools include the:

Traceability window·

Relationship Matrix·

Gap Analysis Matrix·

Relationships window·

Project Browser, and·

Traceability diagrams·

The Traceability window, in particular, is designed to
provide very detailed information on an element's
relationships and dependencies, both immediate and distant.

Tracing Transformations

If you have performed any transformations in developing
your model and code, Enterprise Architect automatically
creates Transformation Dependency connectors that you can
trace - using the Traceability window - to establish what
objects and code have been generated from each PSM
element, or what the initial PSM element was for a
generated object.

Whether you use transformations or develop the stages of
the model in other ways, you can build up a range of
Traceability diagrams (Custom diagrams) to identify the
development pathway and the dependencies between entities
such as Requirements, Use Cases, Classes, Packages, Test
Cases and other model artifacts, or even between these
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entities and the overall business process model.
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Traceability Tools

The structure of your model and a Traceability diagram act
as the starting points for tracing the definition, design and
implementation of a specific feature of a system or process.
By applying tools such as the Relationship Matrix and
Traceability window, you can follow threads through the
model to determine how the feature is implemented and
tested. You can also obtain information on what elements
realize and are realized by the elements in a given Package,
using the Dependency report and Implementation report,
respectively.

Principal Tools

Tool Detail

Traceability
window

The Traceability window is a very useful
and versatile traceability tool; starting
with a Traceability diagram or a Package
structure in the Project Browser, you can
use the Traceability window to quickly
explore the relationship chain of which
any element is a component.

When you click on an element, it·

immediately becomes the top point in
the Traceability window
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When you click on the background of a·

diagram, all elements in the diagram
are listed in the Traceability window,
and you can follow the threads starting
at each element through the diagram

If you require a rapid, broad-brush view
of relationship flows in the project
structure, starting with a general list of -
say - all functional Requirements, you
can use a combination of Model Search,
Project Browser and Traceability
window; this is a powerful means of
scanning your project, identifying how
elements have been organized, and seeing
how they interact. For example, the
Model Search would list all the
Requirements. You could rapidly click on
each element and immediately see in the
Project Browser where it has been
grouped, and at the same time - in the
Traceability window - how that element
interacts with other elements in the
model.
By moving the cursor around a diagram
or the Project Browser, and/or changing
the relationship type combinations in the
Traceability window, you can quickly see
how elements are connected and how
they influence each other. For example,
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you could see that - say - REQ017 is
realized by two Use Cases, so you might
then explore what else influences and is
influenced by these two Use Cases. The
Traceability window takes you well
beyond what is likely to be depicted on
any single diagram.
If you have used transformations to
develop your model, you can also follow
the Transformation Dependencies that
exist between an element in a PIM and
elements in the PSMs.

Relationship
Matrix

Using the Relationship Matrix, you can
both create and study the relationships
between, for example, the Requirements
and Use Cases of a module.
You might identify the 'theme' Package
(such as Manage Users) as the source
Package in the Requirements model and
the target Package in the Use Case model,
and explore the likely element and
connector types in the Packages; this,
similar to the Traceability diagram,
identifies which Requirements are (or
should be) realized by which Use Cases.
You can then perform similar checks with
the Manage Users Packages in, say, the
Use Case and Implementation models.
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Using the 'Source' and 'Target' field
browsers ( ) you can examine child
Packages within the 'theme' Package, and
obtain further detail on how the feature at
this stage is defined.

Relationships
window

The Relationships window shows a single
level of relationships from the currently
selected element.
Each line corresponds to a single
relationship, providing information about
that relationship and the element at the
other end of the relationship.

Dependency
report

The Dependency report provides a list of
dependencies for all elements in the
model.

Implementati
on report

The Implementation report provides a list
of all elements in the model that have to
be implemented, and the elements that
implement them.
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The Traceability Window

Using the Traceability window you can quickly see how
elements are connected and how they influence each other.
You can:

Locate related elements in the Project Browser·

View the properties of related elements·

Open the diagrams in which related elements are used·

Add related elements to the current diagram·

View the source code for related elements·

Change the display using the window toolbar options·

When an element is selected, it immediately becomes the
top point in the Traceability window. When a diagram is
selected, all elements in the diagram are listed in the
Traceability window, so you can use any of them as a
starting point.

Access

Ribbon Design > Impact > Traceability

Keyboard
Shortcuts

Ctrl+Shift+4
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Traceability window toolbar options

Option/Icon Action

Locate
Element

Click on this icon to make the selected
element the focus of the Traceability
window and to show all relationships and
elements with which the selected element
forms a relationship chain.
Click on the diagram to list all elements
in the diagram.

Related
Element
Properties

Click on this icon to display the element
'Properties' dialog for the
currently-selected element in the
Traceability window.

Find Element
Usage

Click on this icon to display the 'Element
Usage' dialog, listing all diagrams in
which the currently-selected element is
used.
(Shortcut keys: Ctrl+U)

(Relationship
selector)

Click on the drop-down arrow and select
the checkbox against each relationship
type to include in the trace shown in the
window:
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Generalizations·

Aggregations·

Nesting·

Realizations·

Dependencies·

Transitions·

Other (unspecified) links such as:
Associations·

Use Cases·

Delegates·

Assemblies·

Deployments·

Information Flows·

Manifests·

Classifiers - where an element is used·

as the classifier of another element
Embedded Element Re-uses - where a·

Port or Part is also represented in
another part of the model
Transformations - where an element is·

created by running a Transformation
from another element
Custom References that have been·

added between elements
Tagged Value References - showing·

elements that are the targets of Tagged
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Value references
Qualified Names - element names·

including the names of owning objects

Help Click on this icon to display this Help
topic.

Traceability Window Context Menu Options

Right-click on an element or connector in the main panel.
All options listed here act on elements only, except for the
'Properties' option which acts on connectors.

Option Description

Switch to
Related
Element

Make the selected element the focus of
the Traceability window. The element
displays at the top of the window.

View Related
Element
Properties

Display the 'Properties' dialog for the
selected element.
You can also display the element's
'Properties' dialog by double-clicking on
it.

Find in all Display the 'Element Usage' dialog,
listing all diagrams in which the
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Diagrams currently-selected element is used.

Place
element(s) in
diagram

This option is available if the selected
element is not used in the diagram that is
the current focus. Select the option to add
the element and its child structure to the
diagram.
You can also simply drag the element
(with its structure) onto the diagram from
the Traceability window.

View Source
Code

Display the generated source code for the
selected element, in the Source Code
Editor.

Properties (For a connector) Display the 'Properties'
dialog for the connector.
(Double-clicking on a connector expands
and collapses any structure beneath it,
rather than displaying the 'Properties'
dialog.)

Notes

To make it easier and faster to find the elements you are·

interested in, restrict the relationship types shown to the
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smallest set of relevant types

As an alternative view, or to include the traceability·

information in documentation, you can develop a
Traceability diagram using the Traceability window

The Traceability window does not currently recognize·

extended relationship types defined by Technologies such
as BPMN or ArchiMate; relationships defined by a Profile
or Technology are identified using their base UML type,
so, for example, ArchiMate 'Realization' and 'UsedBy'
relationships are each reported as UML 'Dependency'
relationships
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Relationship Matrix

When you need to visualize or manage relationships quickly
and definitively, you can use the Relationship Matrix - a
convenient and simple tool for reporting and working on all
the relationships in a selected structure. The Relationship
Matrix is a spreadsheet display of relationships between
model elements within a Package, or between elements in
two different Packages. You can filter the selection of
relationships shown, according to:

The element type of the source and target elements in·

each relationship

The relationship type and direction·

The Package(s) in which the source elements and target·

elements are held

The matrix shows all the relationships of a specified type
between source and target elements by:

Listing the source Package elements down the side of the·

matrix

Listing the target Package elements across the top of the·

matrix, and

If a relationship exists between a source and target·

element, displaying an arrow indicating the direction of
the relationship

The direction is a reflection of which element is the source
element and which the target (it does not indicate the
'Direction' property of the connector, as defined in the
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connector 'Properties' dialog). The display might also show
a 'bent arrow' icon, indicating that the same kind of
connectors exist in both directions between the source and
target elements.

The squares or cells of the matrix can have different fill
colors, depending on the existence of relationships and the
lock status of the Package containing the source element. If
the cell is:

White - there is no relationship between the source·

element in this row and the target element in this column

Pale Blue - the source element on this row has no·

relationships at all (if the Matrix Option 'Highlight source
elements without relationships' is selected)

Pale Pink - the target element in this column has no·

relationships at all (if the Matrix Option 'Highlight target
elements without relationships' is selected); if there is an
intersection of blue rows and pink columns, the blue takes
precedence

Green - with a direction arrow, the elements in the source·

row and target column have a relationship and the source
element is not locked (the parent Package has not been
checked in under Version Control)

Dark Pink - with a direction arrow, the source element is·

locked (the parent Package has been checked in)

Dark Blue - the selected cell, the source element or the·

target element have been selected as the object of an
action within the Relationship Matrix; if just the cell is
selected, the source and target element names are also
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highlighted

Right-clicking on a square gives you the options of creating,
modifying and deleting relationships between elements with
a single mouse click - a quick way to set up complex sets of
element relationships with a minimum of effort.

You can also create additional elements in the source and
target Packages, and quickly add relationships to and/or
from them.

Access

Ribbon Design > Impact > Matrix

Context
Menu

Project Browser |Right-click on Package |
Relationship Matrix | (As Source, As
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Target or As Both)

Operations

Operation Detail

Specify the
element types

The Relationship Matrix defaults to show
all element types. If you want to examine
relationships between specific types of
element, you can filter for those types.
You define the element types - if
necessary - as the first step in configuring
the Relationship Matrix.
Click on the drop-down arrow in the
'Type' field in the 'Source' row, and/or in
the 'Target' row, and in each case click on
the required element type in the list.
The Relationship Matrix display
immediately refreshes.

Specify the
connector
type and
direction

The Relationship Matrix requires a
relationship type and direction to operate
on.
In the 'Link Type' field, click on the drop
down arrow and on the type of
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relationship to show.
In the 'Direction' field, click on the
drop-down arrow and on one of the
connector directions to show, or on 'Both'
to show relationships in any direction.
In each case, if any relationships of that
type exist they are immediately shown on
the Relationship Matrix.

Select the
Source and
Target
Packages

You need to set the source and target
Packages in order to display
relationships, but you do this after setting
the connector and element types; as the
Matrix automatically refreshes after each
change, this is usually faster.

Update,
delete and
create
relationships

Having seen what relationships currently
exist between the selected elements, you
can review the relationship and element
properties, modify them, add more
relationships or delete relationships that
are no longer applicable.

Create new
elements

If the source or target element 'Type' field
is set to a specific element type, you can
add elements of that type to the matrix
and the model.
In the top left corner of the matrix itself,
the 'Target' and 'Source' labels have a +
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button. When you click on this button,
the element 'Properties' dialog displays,
through which you can define a new
element of the corresponding (target or
source) type.
If there are stereotyped elements of the
type (such as Actors as defined in UML,
TOGAF and ArchiMate) you are
prompted to select the variant that you
need.
This option is not available for the target
or source axis if the corresponding 'Type'
field is set to '<All>'.

Modify the
display of
information

It is possible to tailor the display of
information to, for example, list the
Package elements in alphabetical order,
show elements from the Package
hierarchy, highlight elements with no
relationships, and hide or show additional
element name components such as level
numbering, aliases and parent Package
names.

Toggle
Between
relationship
direction and
CRUD

You can switch the display between the
connector direction format and a CRUD
matrix format. The CRUD (or other,
customized) indicators are defined in an
overlay that you create.
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formats

Export the
contents of
the
Relationship
Matrix

After reviewing the Relationship Matrix,
you can export the contents to a CSV file,
or capture the image of the contents as a
.png file or a .emf graphics file.

Print the
contents of
the
Relationship
Matrix

You can also send the contents of the
Relationship Matrix to a printer, after
previewing the print format if necessary.
The printout can be on as many pages as
it takes, or you can scale the print format
so that the file occupies a specific number
of pages.

Capture the
Matrix
settings

If you want to use the same Relationship
Matrix settings repeatedly to, for
example, monitor development of the
same source and target Packages, it is
possible to save the settings as a profile
that can be called to reapply those
settings.

Investigate
Source and
Target
elements in
relationships

Having identified relationships that might
be of significance to you, you can check
details of the elements in those
relationships. For example, you can look
at:
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The diagrams that the elements are·

used in
The properties of the elements, or·

What other elements might have·

relationships with the selected element
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Set Element Type

The Relationship Matrix defaults to show all element types
in both Source and Target Packages. You can also select to
list elements of one specific type in the Source Package or
the Target Package or both. For example:

Any (<All>) types of element in the Source Package·

linked to Use Cases in the Target Package

Use Cases in the Source Package linked to any (<All>)·

types of element in the Target Package

Requirements in the Source Package linked to Use Cases·

in the Target Package

Classes in the Source Package linked to Classes in the·

Target Package

Having set the element type for an axis, you can create
further elements of that type within the Relationship Matrix,

Set the source and/or target element type

Ste
p

Action

1 Click on the drop-down arrow in the 'Type' field for
the Source Package, or for the Target Package.

2 Find the required element type in the list and click
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on it.
The Relationship Matrix content automatically
refreshes.

3 If necessary, repeat the process to select a specific
element type in the other Package.
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Set Connector Type and Direction

The Relationship Matrix shows relationships of a specific
type and direction, which you define after selecting the
element type(s) to show, and before you specify the Source
and Target Packages to search in.

Set the connector type and direction

Ste
p

Action

1 Click on the drop-down arrow in the 'Link Type'
field.

2 Locate and click on the required connector type in
the list.

3 Click on the drop-down arrow in the 'Direction' field.

4 Click on the required direction in the list.
The Relationship Matrix content automatically
refreshes.
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Notes

If you set the 'Direction' field to 'Both', each relationship·

is indicated by two arrows - a From-To arrow and a
To-From arrow

The direction is a reflection of which elements are the·

source elements and which are the target; it does not
indicate the 'Direction' property of the connector, as
defined in the connector 'Properties' dialog
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Set Source and Target Package

Before you display relationships on the Relationship Matrix,
you set both the source and target Packages containing the
elements between which the relationships might exist.
However, you set the source and target Packages after
setting the element and connector types/details; as the
Relationship Matrix refreshes after each change, this is
usually faster. You can set the same Package as the source
and target, to investigate relationships within a Package, or
different source and target Packages to investigate
relationships between Packages.

When deciding on which Packages to investigate and how to
filter the matrix contents, consider that:

The Relationship Matrix includes all child elements in·

each Package, within the criteria you specify; in a large
model, with less-specific filters, this can expand the
matrix with a large number of elements

On the other hand, if you want to examine relationships·

within the Package structure, you can select options to
include elements in child Packages under either the source
Package or the target Package, or both

Access

Ribbon Design > Impact > Matrix
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Context
Menu

Project Browser |Right-click on Package |
Relationship Matrix | (As Source, As
Target or As Both)

Set source and target Packages (method 1)

In all cases, the Relationship Matrix immediately:

Populates the axes with the elements identified in the·

'Source Package' and 'Target Package' or searches that
meet the selection criteria, and

Shows any relationships between the sets of elements that·

also meet the selection criteria

If you select the first access option:

Step Action

1 In the Project Browser, click on the
required source Package, then press and
hold Ctrl and click on the required target
Package, to select the two Packages
together.

2 Drag the selected Packages over the
'Source' and 'Target' fields.
The first-selected Package name displays
in the 'Source' field, and the
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second-selected Package name displays
in the 'Target' field.

Set source and target Packages (method 2)

Or, if you use the second access option:

Step Action

1 Select and drag a single Package name
over the remaining 'Source' OR 'Target'
field, to change just the source or the
target Package.
If you drop the Package name anywhere
else on the Relationship Matrix, the
system prompts you to specify whether to
add it to the 'Source' or 'Target' field, or
both.

Set source and target Packages (method 3)

Step Action

1 Click on the  button at the end of the
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'Source' or 'Target' field.
A short menu displays, with options to:

Locate a Package using the 'Browse·

Project' dialog or
Select a Model Search from a·

drop-down list and run the search on a
search term; the name of the search is
displayed in the 'Source' or 'Target'
field
The target of the search depends on
whether the 'Return matching items for
the selected Package' option is selected
in the 'Search' definition; if it is
selected, the search operates on the
current Package, otherwise the search
operates on the whole model

It is possible to browse for a Package in
one field and run a search in the other.

2 Select the required Package, or the
required Model Search and search term,
and click on the OK button.

Notes

Custom SQL searches are supported if they are returning·
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elements; the SQL must include ea_guid AS
CLASSGUID (case sensitive)

Using ORDER BY in a SQL search will not affect the·

order of the Relationship Matrix
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Matrix Overlays

The Relationship Matrix indicates the existence of
connectors between elements by displaying an arrow in the
cell at the intersection of the source element row and target
element column.

If you prefer, you can toggle the display to a CRUD matrix
overlay, where the presence of a connector is indicated by
the appropriate value or combination of CRUD values in the
intersection cell. You define the actual values that are
entered and displayed, so the characters can refer to
whatever interpretation of CRUD your organization uses, or
they can be another standard set of indicators such as
BREAD, or your own custom set of indicators. The values
can, therefore, be a selection of these, or anything else you
might use:

C reate·

A dd·

B rowse·

L ist·

R ead, R etrieve·

U pdate·

E dit·

M odify·

D elete, D estroy·
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Toggle between the two display formats

Click on the 'Overlays' field drop-down arrow and select
either:

'<None>' to use the direction arrow Relationship Matrix·

format

The name of your overlay, to use the Matrix overlay·

format, or

'<New Overlay>' to create and use a new Matrix overlay·

The overlay values display if they have been specifically
applied to the relationship via the intersection cell on the
Relationship Matrix.

(c) Sparx Systems 2018 Page 237 of 281



User Guide - Model Navigation 21 December, 2018

Create a Matrix Overlay

When you create a Matrix Overlay to apply to the cells of
the Relationship Matrix, you define the values that can be
assigned under that overlay, and whether the values must be
single or can be set in a combination. The overlay definition
is actually created as a Tagged Value on the connector, of
the predefined Tagged Value Type MatrixOverlay.

Access

Ribbon Design > Impact > Matrix : Overlays
drop-down arrow | <New Overlay>

Context
Menu

Project Browser |Right-click on Package |
Relationship Matrix | (As Source, As
Target or As Both) : Overlays drop-down
arrow | <New Overlay>

Create an Overlay

Field/Button Action
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Overlay
Name

Type an appropriate name for the overlay.
This also becomes the tag name.

Allowable
Values

Type in the allowable values for the
overlay/tag, not separated by any
punctuation or spaces (for example,
CRUD); the matrix cell is case sensitive,
so type the values exactly as they are to
be entered.

Mutually
Exclusive

If you want only one allowable value to
be set in a matrix cell at a time, select this
checkbox. (This makes the Tagged Value
an Enum type.)
If you want to allow any combination of
values to be set in a matrix cell at a time,
clear the checkbox. (This makes the
Tagged Value a Custom type.)

OK Click on this button to save the new
overlay/Tagged Value.
You can now view the overlay on the
'Tagged Value Types' tab of the 'UML
Types' dialog, in the format:

Type=Enum;Values=C,R,U,D;MatrixOve
rlay=true;
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Notes

You cannot change an existing overlay on the·

Relationship Matrix; because the overlay is defined by a
Tagged Value of type MatrixOverlay, you can delete the
overlay or edit the values and/or the 'Mutually Exclusive'
setting by deleting or editing the Tagged Value on the
'Tagged Value Types' tab of the 'UML Types' dialog
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Apply an Overlay to a Cell

You can apply overlays (one overlay at a time) to the cells
of the Relationship Matrix. After you select the required
overlay in the 'Overlays' field, you can:

Apply an overlay value or values to a cell that identifies·

an existing relationship

Create a new relationship in a cell, and immediately apply·

overlay values to that relationship

Change the overlay values currently applied, or·

Remove the overlay from the cell·

Access

Ribbon Design > Impact > Matrix : right-click on
cell

Context Menu - Overlay Options

Option Action

Apply (On a cell that has an arrow icon, or the
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overlay value of a different type of overlay.)
Displays the 'Allowable values <values>'
dialog. Type in the required value or
values and click on the OK button.

If you have entered more than one·

value and the overlay is set to mutually
exclusive, only a single value is
permitted and an error message
displays; click on the OK button and
type in a single character
If the overlay is not set to mutually·

exclusive, you can type in any
individual value, or any combination of
values in any sequence

Create new
relationship
with overlay

(On a cell that has no relationship
indicated in it.)
If necessary, change the 'Link Type' field
to show the type of connector to create.
When you click on the menu option, a
submenu of variations of the selected
relationship type might display. Click on
the variation to create.
The 'Allowable values <values>' dialog
displays; type in the required value or
values and click on the OK button.
A relationship of the selected type is
created between the source and target
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elements, and the selected overlay values
are displayed in the cell.

Edit overlay (On a cell showing a value of the current
overlay.)
Displays the 'Allowable values <values>'
dialog, showing the current value.
Overtype this with the new value or
values and click on the OK button.
The new value(s) display in the selected
cell.

Remove
overlay

(On a cell showing a value of the current
overlay.)
Clears the overlay value and restores the
appropriate connector direction arrow
symbol to the cell.

Notes

You cannot apply different overlays to the matrix at the·

same time; if you select a different overlay in the
'Overlays' field, any values in the cells revert to either the
value set under that overlay, or the direction arrow if no
value is set under that overlay
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Matrix Profiles

You can use the Relationship Matrix as a monitoring tool, to
help in tracking the development of elements and
relationships in particular Packages or pairs of Packages
over time. In this case you would re-use the same
combinations of field settings many times. It is very easy to
store a combination of settings as a matrix profile, so that
later you can recall it for use whenever you need it.

Access

Ribbon Design > Impact > Matrix

Context
Menu

Project Browser |Right-click on Package |
Relationship Matrix | (As Source, As
Target or As Both)

Save a Relationship Matrix configuration as
a named profile

Ste
p

Action
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1 Set up the Relationship Matrix with the required:
Source and target element types·

Connector type and direction·

Source and target Packages or Model Searches,·

and
Overlay name or <None> selected·

2 Click on the Options button on the Relationship
Matrix and select 'Profiles | Save as New Profile'.
The 'Enter name for new profile' dialog displays.

3 In the 'Enter Value' field, type a profile name of up
to 12 characters.
Click on the OK button.

4 Once you have created a profile, you can select it by
clicking on the Profile drop-down arrow at the top of
the Relationship Matrix screen and selecting the
profile name from the list.
Profiles are also listed in the Matrix Profiles folder
of the Resources window; double-click on a profile
in the folder to display the Relationship Matrix with
that profile active.

Notes
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You can modify an existing profile by:·

-   Selecting the profile name from the 'Profile' drop-down
list
-   Changing the field values, then
-   Selecting 'Options: Profiles | Update Current Profile'

To delete an existing profile, select it in the 'Profile'·

drop-down list and select 'Options: Profiles | Delete
Current'

You can capture Relationship Matrix profiles in document·

reports

In the Corporate, Unified and Ultimate editions of·

Enterprise Architect, if security is enabled you must have
'Configure Resources' permission to Save, Update, or
Delete matrix profiles
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Creating and Deleting Relationships

Having reviewed existing relationships on the Relationship
Matrix, you can use the Matrix to quickly modify or delete
those relationships and create others between the elements.
This is a very useful facility for maintaining a large number
of relationships in a short space of time. As you can filter
for specific types of connector and source and target
element, you can create a logical set of relationships without
having to specify the type of each object every time.

Access

Ribbon Design > Impact > Matrix

Context
Menu

Project Browser |Right-click on Package |
Relationship Matrix | (As Source, As
Target or As Both)

Create a new relationship

Ste
p

Action
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1 In the 'Link Type' field, select the type of
relationship you want to create, and in the 'Type'
fields select the types of source and target element
between which to create the relationships.

2 Right-click on the empty square at the intersection of
the appropriate source row and target column.
You can select and operate on several squares
(creating several relationships) at once. Either:

Press Ctrl as you click on each intersecting square,·

then right-click on one of the selected squares, or
Click on the first square in the required row,·

column or block, then press Shift as you click on
the final square in the required row, column or
block; right-click on one of the selected squares

3 Select either the:
'Create new relationship' option, if no overlay is to·

be applied
'Create new relationship with overlay' option, to·

apply an overlay as you create the relationship
If the 'Direction' field is set to 'Both', you are offered
the choice of creating the relationship to the Source
element or to the Target element.
A further submenu might display, listing any
variations on the type of relationship you can create;
in this case, click on the required type of

(c) Sparx Systems 2018 Page 249 of 281



User Guide - Model Navigation 21 December, 2018

relationship.

4 A connector of the selected type is created between
the two elements, and the appropriate indicator
displays in the matrix cell.

Modify or delete a relationship on the
Relationship Matrix

Ste
p

Action

1 Right-click on the required highlighted relationship
cell on the matrix, and select the appropriate context
menu option:

Apply overlay - apply the CRUD overlay, if one is·

selected
Edit overlay - change the overlay values assigned·

to the cell
Remove overlay - take the overlay off this cell·

only, and revert to the connector direction arrow
icon
View relationship - open the 'Properties' dialog for·

the selected relationship
Source element properties - open the 'Properties'·
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dialog for the source element
Target element properties - open the 'Properties'·

dialog for the target element
Delete relationship - remove the relationship from·

between the elements

2 If you have selected 'Delete relationship', Enterprise
Architect prompts you to confirm this action.
Click on the Yes button.
The 'Delete relationship' option is not available if:

The source element (that is, the owner) is locked·

You have selected 'Both' in the 'Direction' field -·

you are effectively trying to delete half a
relationship

3 If you have selected one of the other options, modify
the properties in the dialog fields as required.
Click on the OK button to save the changes.
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Relationship Matrix Options

When you have displayed information on the Relationship
Matrix, you might want to capture the display in some way,
or modify the output. There are a number of options that you
can select to, for example:

Output the information on the Relationship Matrix to the·

printer or to a metafile, .png file or .csv file

Create and update profiles of the configurations of the·

matrix that you have designed

Define local settings to control what the Relationship·

Matrix displays

Access

Ribbon Design > Impact > Matrix : Options

Context
Menu

Project Browser |Right-click on Package |
Relationship Matrix | (As Source, As
Target or As Both) : Options

Options

(c) Sparx Systems 2018 Page 252 of 281



User Guide - Model Navigation 21 December, 2018

Option Action

Print
Relationship
Matrix

Click on the 'Matrix | Print' menu option.
The 'Print' dialog displays, on which you
select the output printer and specify the
printer properties, the range of pages to
print, and the number of copies.
The output is a WYSIWYG
representation of the Relationship Matrix
contents.

Display a
preview of
the printout

Click on the 'Matrix | Print Preview'
menu option.
The 'Print Preview' screen displays,
showing the Relationship Matrix printout.

Scale the
printout

When you print the Relationship Matrix,
by default it prints on as many pages
wide and long as the Matrix requires.
You can scale the printout into a fixed
number of pages wide; the row height is
automatically adjusted to maintain the
proportions of the Matrix. This reduces
the overall size of the printout and
improves appearance, especially when
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used in conjunction with the 'Landscape'
option in the printer properties.
For example, a 16-page printout without
scaling can, with a scaling of 2 pages
wide, be reduced to 6 pages.
To set the page scaling:

Click on the 'Matrix | Scale Setting'1.
menu option. The 'Scale Matrix' dialog
displays.
Select the 'Scale Matrix Width Into2.
Pages' checkbox, and type or select the
number of pages in width to scale to.
Click on the OK button to apply the3.
setting.

Save
Relationship
Matrix as
graphic file

Click on the 'Matrix | Save as Metafile' or
'Matrix | Save as PNG' menu options.
A browser dialog displays on which you
select the target file location and specify
the filename of the .emf or .png file in
which to save the output.
You can incorporate these files in a
document or web report, as either a
hyperlinked file or an included file.

Export output
to CSV file

The contents of the Relationship Matrix
can be exported to a CSV file, which
provides a convenient mechanism for
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moving the matrix data to a spreadsheet
environment such as Microsoft Excel.
This option is also active in the 'Lite',
read-only version of Enterprise Architect.
To export the Matrix to CSV:

Select the 'Matrix | Export to CSV'1.
menu option. The Windows 'Browser'
dialog displays.
Browse to the required file location2.
and type in a .csv filename to export to.
Click on the Save button to export the3.
data.

Create and
manage
matrix
profiles

If you use a particular combination of
field values often, you can save that
combination as a profile to make it easier
to recall them for use.
You can also include a Relationship
Matrix Profile in a document report, to
pull in specific relationship details using
the Matrix.

Manage
display
content

You can extend the information shown by
the Relationship Matrix to include related
elements and/or additional properties of
each element. You can also re-organize
the display to list the element names in
alphabetical order.
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Select the 'Options' menu option. The
'Matrix Options' dialog displays. Select
one or more of these checkboxes to
define the information you want to
display:

'Include Source Children' - to·

recursively include child Packages and
contents under the Source
'Include Target Children' - to·

recursively include child Packages and
contents under the Target
'Include All Extended Meta Types' - to·

include elements that are extensions of
a specified meta-type; for example, if
there are Block elements (extending
Class) in the Package, selecting this
option and specifying the type Class
includes Class and Block elements, and
any further derivatives of Class in the
matrix
'Sort Axes' - to display the element·

names in alphabetical order
'Show Package Names' - to hide or·

show the elements' parent Package
names in the Relationship Matrix; this
is useful for shortening the displayed
texts, especially in circumstances
where Packages have long names
'Use Element Alias If Available' - to·
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display an element's alias instead of the
element name, if an alias has been
defined
'Show Level Numbering If Available' -·

to reproduce level numbering in the
Relationship Matrix, if it is turned on in
the Project Browser
'Highlight source elements without·

relationships' - to display, in pale blue,
all cells in a row belonging to a source
element that has no relationships
'Highlight target elements without·

relationships' - to display, in pale pink,
all cells in a column belonging to a
target element that has no relationships

(c) Sparx Systems 2018 Page 257 of 281



User Guide - Model Navigation 21 December, 2018

Review Source and Target Elements

As you review the information on relationships in the
Relationship Matrix, you can also obtain information on the
source and target elements in any of the relationships.

Access

Ribbon Design > Impact > Matrix

Context
Menu

Project Browser |Right-click on Package |
Relationship Matrix | (As Source, As
Target or As Both)

Review the elements

Action Detail

Identify other
elements in
relationships
with a source
or target

Click on the source or target element
name in the row or column titles.
The entire row or column is highlighted.
Scroll across or down the highlighted row
or column and quickly identify where the
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element relationships are; this is very useful if the
row or column is long.

Display the
'Properties'
dialog for the
selected
element

Right-click on the element name and
select the 'Properties' option.

Identify
diagrams in
which the
element is
used

Right-click on the element name and
select the 'Find in Diagrams' option.
Either:

The only diagram in which the element·

is used displays, with the element
highlighted, or
A list of the diagrams in which the·

element is used displays; you then
double-click on the required diagram to
open it

Highlight the
element
name in the
Project
Browser

Right-click on the element name and
select the 'Locate in Project Browser'
option.
The Project Browser expands to the
location of the element, and the element
name is highlighted.

Make the
element the

Right-click on the element name and
select the 'Set Context Item' option; the
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focus in any
docked
screens or
windows that
are open

selected element becomes the subject of
any other windows or screens that are
open.
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The Relationships Window

If you want a quick overview of all the relationships of one
or more elements in the model, you can obtain this from the
Relationships window. This window lists all the
relationships of the elements currently selected in a diagram
or the Project Browser, showing:

The relationship type·

The direction, or navigability, of the relationship·

Any stereotype on the relationship·

The names of the source and target elements in the·

relationship (names in parentheses indicate that the
element is not shown on the currently-open diagram); the
selected elements can be either source or target in the
relationship

Characteristics of the source and target elements, such as·

type, stereotype, role, cardinality

This information is presented in a series of columns that you
can display or hide to show only the characteristics you
require, and organize in whatever sequence suits your
requirements. You can also group the information (for
example, by source or target element) and filter the
information to show only items having particular values.

The Relationships window has a 'View' column which, if the
row contains the value 'Visible' or 'Hidden', indicates that
the related element is present in the currently open diagram
and the relationship to it is visible or hidden. If the related
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element is not in the current diagram (the row has no value),
you can add it.

You can perform operations on each relationship using the
options from a context menu.

Access

Ribbon Show > Portals > Window > Trace >
Relationships
Start > Explore > Trace > Relationships

Keyboard
Shortcuts

Ctrl+Shift+2

Facilities

Facility Detail

Reorganize
display

You can click on and drag column
headings across the display to arrange
them in a different sequence.
You can also right-click on the column
headings and set up the types and values
of information to display, using the Field
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Chooser, Group Box and Filter Bar.

Display
Connector
Properties

Either:
Double-click on a relationship in the·

list
Click on the relationship and press the·

G key, or
Right-click and select 'General·

Properties'
The '<connector type> Properties' dialog
displays showing the 'General' tab, on
which you can view and edit the
connector properties.

Display
Properties of
Source Role

Either:
Double-click on a relationship in the·

list and select the 'Role(s)' tab
Click on the relationship and press the·

S key, or
Right-click and select 'Source Role'·

The '<connector type> Properties' dialog
displays showing the 'Roles' tab, on
which you can view and edit the
properties of the Source Role defined in
the relationship.

Display
Properties of

Either:
Double-click on a relationship in the·
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Target Role list and select the 'Role(s)' tab
Click on the relationship and press the·

T key, or
Right-click and select 'Target Role'·

The '<connector type> Properties' dialog
displays showing the 'Roles' tab, on
which you can view and edit the
properties of the Target Role defined in
the relationship.

Hide / Show
connector on
diagram

If the related element exists on the
current diagram, and the connector is
shown (the 'View' column has the value
'Visible'), you can hide it. Right-click on
the item line and select 'Hide Relation'.
If the related element exists on the
diagram and the connector is hidden (the
'View' column has the value 'Hidden'),
you can re-display it. Right-click on the
item line and select 'Show Relation'.

Apply
Appearance
to One or
More
Connectors
On the
Current
Element on

Select one or more relationships, then
right-click and select 'Appearance'.
On the 'Connector Appearance' dialog,
click on the drop-down arrow in the:

'Line Color' field, and select the color·

to apply to the connector lines
'Line Thickness' field, and select the·
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the Current
Diagram

line thickness of the connector lines
Click on the OK button to apply the
settings to all the selected connectors on
the element.
For the selected connectors, you can also
right-click and select 'Line Style', and one
of the listed styles. The style is
immediately applied to the connectors on
the diagram.

Display the
properties of
the Source
element

Either:
Right-click on the relationship item and·

select 'Source Properties', or
Click on the item line and press the·

Enter key
The element 'Properties' dialog displays
for the source element in the relationship.

Display the
attributes or
operations of
the Source
element

Right-click on the relationship item and
select 'Source Features | Attributes' or
'Source Features | Operations'.
(Alternatively, click on the item and press
F9 or F10, respectively).
The Features window displays for the
source element, showing the 'Attributes'
or 'Operations' tab as appropriate.

Display the Either:
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properties of
the Target
element

Right-click on the relationship item and·

select 'Target Properties', or
Click on the item line and press·

Shift+Enter
The element 'Properties' dialog displays
for the target element in the relationship.

Display the
attributes or
operations of
the Target
element

Right-click on the relationship item and
select 'Target Features | Attributes' or
'Target Features | Operations'.
(Alternatively, click on the item and press
Shift+F9 or Shift+F10, respectively).
The Features window displays for the
target element, showing the 'Attributes' or
'Operations' tab as appropriate.

Find Related
Element in
Project
Browser

Right-click on the item line and select
'Locate Source' or 'Locate Target' as
appropriate.
The related element is highlighted in the
Project Browser.

Add Related
elements to
current
diagram

If any related elements are not shown on
the current diagram, then:

The 'View' column has no value and·

The related element name is in·

parentheses ()
You can select the relevant relationships
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and add the elements to the diagram.
Select the item line(s), then right-click
and select 'Place Element(s) in Diagram'.
The cursor changes to the 'drop element'
symbols (small rectangle and arrow with
a boxed plus sign); move the cursor to the
point in the diagram at which to drop the
related elements, and click the mouse
button.
This facility is useful in building up a
picture of how an element interacts with
the rest of the model, especially when
reverse engineering an existing code
base.

Locate
Related
Elements in
Diagrams

Right-click on the item line and select the
'Find in all Diagrams' option.
If the related element exists only in one
diagram, that diagram is displayed with
the related element highlighted. The
focus of the Relationships window
switches to the related element.
If the related element exists in more than
one diagram, the 'Element Usage' dialog
displays, listing the diagrams. Click on
one of the diagrams and on the Open
button to display the selected diagram
with the related element highlighted.
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Delete
Relationship

Right-click on the item line and select the
'Delete Connection' option.
A prompt displays to warn you that the
selected items will be deleted from all
diagrams and from the model, and that
the action cannot be reversed. This
message refers to the relationship only -
the source and target elements remain in
the diagram and in the model.
Click on the Yes button to proceed with
the deletion.

Notes

In the Corporate, Unified and Ultimate editions, with·

security enabled, the diagram and the source and target
elements must be free for editing before these options are
available for use

Adding a related element from the Relationships window·

to the diagram does not change the focus of the window to
that related element; the originally-selected element (and
the original subject of the Relationships window) remains
in context, and you continue working with that element
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Example Traceability Diagram

You can create Traceability diagrams to show a wide variety
of relationships, and you are not restricted to having either a
single element type or elements from a single phase on a
diagram. Therefore, you can create appropriate relationships
(such as Realize or Trace) to elements where no relationship
was previously defined.

Consider this diagram, which shows how a series of
Requirements are traced to Use Cases and then Classes:

The diagram instantly shows:

That two levels of Requirements are realized by Use·
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Cases

Which Requirement is realized by which Use Case(s)·

How some of the Use Cases are implemented by Class·

elements

You can drill down on each Use Case (or, in other
Traceability diagrams, any other composite element) to
display more detailed diagrams showing how the Use Case
meets the Requirement; the Close Account Use Case, for
example, is a composite element containing a
Communication diagram and a Sequence diagram.

You can tailor your Traceability diagrams to depict any
level of granularity and any stages of development that are
appropriate; for example, you might:

Narrow the example diagram to show development from·

just the Remove User Requirement, or

Extend it to include Interfaces, Components, Test Case·

elements or any other facet of the system or process

Building a diagram

A number of tools are available for updating diagrams to
show traceability:

On the diagram, right-click on an element and select the·

context menu option 'Insert Related Elements' to
automatically add elements linked to the selected element

On the Relationships window, use the context menu·

option 'Place Related Element in Diagram' to add

(c) Sparx Systems 2018 Page 270 of 281



User Guide - Model Navigation 21 December, 2018

elements to the diagram that are directly linked to the
selected element

On the Traceability window, add elements that are·

indirectly linked

Notes

Whilst the Traceability diagram itself provides·

information on the definition, design and implementation
of a business process feature, much more information can
be obtained using the Traceability tools
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Gap Analysis Matrix

The Gap Analysis Matrix is a convenient tool for analyzing
model artifacts to identify potential gaps between solution
architectures.

The idea is to highlight a shortfall between the Baseline
Architecture and the Target Architecture; that is, items that
have been deliberately omitted, accidentally left out, or not
yet defined. You can then model the gaps in the repository,
which can later be addressed and assigned as tasks; the
identified gaps can also be used to prioritize activities.

On the Gap Analysis Matrix, you select the:

Target Architecture Package·

Baseline Architecture Package·

Type of Target Architecture artifact·

Type of Baseline Architecture artifact·

Type of element to model the gap·

Access

Ribbon Design > Impact > Gap Analysis

Operations
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Once you open the Gap Analysis Matrix, you can:

Create, update and delete Gap Matrix Profiles to monitor·

development of the Baseline and Target Packages

Edit Gap notes during a discussion session for Gap·

analysis

Create elements to address gaps·

Add links to existing elements to address gaps·

Remove links to existing elements modeled as gaps·

Operation Description

Select
Package

Click on the  button at the end of the
'Target Architecture' or 'Baseline
Architecture' field.
The 'Browse Project' dialog displays.
Select the required Package and click on
the OK button; by default all the elements
under the Package are displayed.

Set Element
Type

Click on the drop-down arrow in the
'Filter' field for the Target Architecture
Package, and/or for the Baseline
Architecture.
Find the required element type in the list
and click on it; Enterprise Architect
refreshes the matrix content.

Click on the drop-down arrow in the
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Set Gap Type 'Record Gap As' field.
Find the required element type in the list
and click on it.
When you create a gap, the specified type
of element is created; for example, if you
want to address the gap with an issue
element then select 'Issue' for this field.

Baseline
Architecture

The Baseline Architecture artifacts are
listed along the rows of the matrix.
The last row is for capturing the new
elements in the target architecture along
the columns but not in the baseline
architecture, hence the name 'New'.

Target
Architecture

The Target Architecture artifacts are
listed along the columns of the matrix.
The last column is for capturing the
missing or intentionally eliminated
elements in the baseline architecture
along the rows but not in the target
architecture; hence the name Missing /
Eliminated.

Modeling
Gap

Right-click on a cell in the 'New' row or
'Missing / Eliminated' column.
The context menu displays options to:

'Create a Gap element'·
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'Add a link to an existing Gap element'·

If a link to Gap element already exists in
the cell, these options are displayed:

'Edit Gap element'·

'Find in Project Browser...'·

'Remove Gap element link'·

Create Gap Right-click on the cell and select the
'Create Gap Element' option.
The 'Browse Project' dialog displays.
Select the Package in which to create the
Gap element and click on the OK button;
a Gap element is created in the selected
Package and its 'Properties' dialog
displays to enable you to enter the
element name and other required
properties.

Link to
Existing Gap

If you intend to use a Gap element that is
already available in the model, right-click
on the appropriate cell in the 'Missing /
Eliminated' column or 'New' row and
select the 'Link to Existing Gap Element'
option.
The 'Select Classifier' dialog displays,
enabling you to select the existing Gap
element.
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Remove Link
to Gap

If you intend to remove a link to the Gap
element in a cell, right-click on the
appropriate cell in the 'Missing /
Eliminated' column or 'New' row and
select the 'Remove Link to Gap Element'
option.
The link is removed from the cell but the
element still exists in the Project
Browser.

Review Gap
Element

Right-click on the appropriate cell in the
'Missing / Eliminated' column or 'New'
row and select the 'Edit Gap Element'
option.
The 'Properties' dialog displays, enabling
you to edit the selected Gap element.
To locate the element in the Project
Browser select the 'Find in Project
Browser...' context menu option, which
highlights the element in the Project
Browser.

Gap Analysis
Matrix
Profiles

On the Gap Analysis Matrix, you can
create and manage profiles to save
commonly-used combinations of Target
Architectures, Baseline Architectures and
stereotypes.
To work on Gap Analysis Matrix
profiles, click on the Options button in
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the top right corner of the matrix; a
submenu displays, listing options to:

Create / Save the current matrix·

settings and content
Update the currently selected profile in·

the 'Profile' field
Delete the currently selected profile in·

the 'Profile' field

Open a saved
Profile

The 'Profile' field drop-down list shows
all the saved Gap Analysis Matrix
profiles.
Click on the drop-down arrow in the
'Profile' field, find the required Profile in
the list and click on it to load the content
of the selected profile in the matrix.

Notes

The Gap Analysis Matrix is available in the Corporate,·

Unified and Ultimate editions of Enterprise Architect

You can transport your Gap Analysis Matrix profiles·

between projects, using the 'Configure > Model >
Transfer > Export Reference Data' and 'Import Reference
Data' ribbon options
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Edit Gap Notes

The Gap Analysis Matrix provides a way to record notes
during the initial phase or during a discussion session for
Gap Analysis. These notes are saved in profiles, which can
later be reviewed and the appropriate model elements
created to address these gaps.

Edit gap notes

Ste
p

Action

1 Right-click on the cell at the intersection of a Target
and Baseline element and select the 'Edit Gap Note'
option.
Alternatively, double-click on the cell.
The 'Gap Note' dialog displays.

2 Edit the notes as required and click on the OK
button.

3 The edited notes display in the selected cell in the
matrix.

4 Update or save the matrix to retrieve it when the Gap
Matrix profile is loaded at a later stage.
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